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UPOZNÁMKA 

 

GCC má právo měnit informace obsažené v tomto manuálu bez jakéhokoli upozornění; je zakázané 

kopírovat a měnit tuto příručku. Všechny komentáře, dotazy nebo návrhy vztahující se k tomuto manuálu 

konzultujte s vaším dealerem. 
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Důležité bezpečnostní upozornění 
Přečtěte si, a dodržujte prosím, všechny instrukce, stejně tak jako varování v příručce: 

 

• Se strojem může pracovat pouze oprávněná osoba starší 18 let. 

• Používejte zařízení pouze pro jeho určený účel umístěným na vhodném pracovišti. 

• K připojení používejte správně instalovanou síťovou zásuvku s ochranou proti úrazu elektrickým 

proudem.  

• Pokud je nezbytně nutný prodlužovací kabel, měli byste použít 20 ampérový. Při použití kabelu 

určeném na menší velikost proudu, může dojít k přetížení. 

• Zkontrolujte, zda údaje o napájení na typovém štítku souhlasí s parametry elektrické sítě.  

• Pokud je síťová zásuvka uvolněná, nezapojujte do ní síťovou zástrčku. 

• Je třeba dbát, abyste kabel umístily tak, aby nebyl napnutý anebo o něj nikdo nezakopl. 

• Nepracujte s přístrojem s poškozeným kabelem, anebo pokud vám přístroj upadl nebo je 

poškozen.  

• Nenechávejte přístroj bez dozoru, pokud je zapojen. Po dokončené práci lis vypínejte. 

• Neponořujte přístroj do vody nebo jiné tekutin. Mimo jiné HROZÍ riziko úrazu elektrickým 

proudem. 

• Při odpojování nikdy netahejte kabel ze zásuvky, místo toho uchopte zástrčku a vytáhněte kabel. 

• Nedovolte, aby se kabel dotýkal horkých povrchů. Nechte přístroj vychladnout na bezpečném 

místě před jeho transportem do skladu. 

• Nerozebírejte ani se nepokoušejte přístroj opravit, odneste ho do autorizovaného servisu na 

vyšetření nebo opravu.  

• Nesprávná montáž nebo oprava může být příčinou požáru, úrazu elektrickým proudem nebo 

poranění osoby, která přístroj používá. 

• Pokud se budete dotýkat horkých kovových částic, mohlo by dojít k popáleninám. 

• Chcete-li snížit pravděpodobnost přetížení obvodu, nemějte ve stejném okruhu další zařízení 

s vysokým napětím. 

• Dodržujte pravidelné funkční a revizní kontroly, dle ČSN a dalších souvisejících platných norem 

a předpisů a zákonů ČR a EU. 

• Hašení přístroje proveďte řádně platným hasícím přístrojem. 

Obal – přeprava: Doporučujeme původní karton (krabice), obal a dřevěný transportní paletu uchovávat 

pro budoucí dopravu tepelného lisu do servisu. Usnadní to eventuální opravy v servisu.  

Oprava: Pokud jsou některé součásti vadné, a to navzdory řádnému použití, autorizovanému použití, a 

nikoliv v důsledku opotřebení a nastane-li porucha v záruční době, pak budou nahrazeny nebo opraveny 

bez jakýchkoliv dotazů za předpokladu, že společnost REFO, s.r.o. byla o takovém nároku písemně 

informována do jednoho týdne od výskytu selhání. 

 

DODRŽUJTE TYTO INSTRUKCE. 
NÁVOD UCHOVEJTE. 
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Důležité informace 
Děkujeme za zakoupení řezacího plotru GCC Jaguar V. Této kapitole věnujte zvýšenou pozornost, protože 

obsahuje rady pro bezpečnou práci s řezacím plotrem. 

 

 
Bezpečnostní opatření 

 
V zájmu bezpečnosti, při přesunu plotru ho vždy držte za spodek. Plotr nechytejte za prohloubeniny na 

obou stranách. 

 
Správně         Špatně 

 

 

• Netřeste nebo neupusťte držák nože, špička nože se může zlomit. 

• Během řezání se nedotýkejte jakékoli pohybující se části přístroje. Při práci s řezacím plotrem si 

dejte pozor na oblečení a vlasy. 

• Vždy zapínejte zdrojový kabel do uzemněného zdroje. 

• Vždy používejte dodaný zdrojový kabel. Nepokládejte zdrojový kabel tak, aby se kroutil nebo byl 

zachycen mezi předměty. 

• Nezapojujte zdrojový kabel do větveného výstupu, do kterého jsou zapojené další přístroje nebo 

do prodlužovacího kabelu. Hrozí přehřátí a chybné fungování přístroje. 

• Držte řezací plotr mimo dosah dětí. 

• Vždy umístěte přítlačná kolečka v rozmezí bílých značek. 
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Varování 
Nikdy nemačkejte horní a dolní část klady ve stejnou dobu. Viz obrázek níže. 

 

SPRÁVNĚ:       ŠPATNĚ: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Horní část kladky 

Zajištění kladky 

Horní část kladky 

ŠPATNĚ 

Uvolnění kladky 

Poznámka: 

V případě, že jsou kladky zaseknuty o sebe, 

způsobené vaším špatným zacházením, 

prosím použijte pinzetu k povytáhnutí 

zarážky, a to pomocí zatlačením na vršek 

kladky. Odstraňte zarážku a pak uvolněte 

kladky správným způsobem. 
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1. Základní informace 
1.1 Úvod 
Řezací plotr Jaguar V byl navržen pro výrobu počítačově vytvořené grafiky nebo k řezání obrysů na 

arších nebo na fóliích. 

Tento manuál byl vytvořen pro následující konkrétní modely Jaguar V: 
 

‧J5-61(LX)/J5-61LXE šíře fólie: 50 mm (1.97”) ~ 770 mm (30.3”) 

‧J5-101(LX) šíře fólie: 50 mm (1.97”) ~ 1270 mm (50”) 

‧J5-132(LX) šíře fólie: 50 mm (1.97”) ~ 1594 mm (62.7”) 

‧J5-183LX šíře fólie: 300 mm (11.8”) ~ 1900 mm (74.8”) 

 

1.2 Příslušenství 
Příslušenství k řezacímu plotru Jaguar V obsahuje následující položky. Zkontrolujte je prosím pečlivě. 

Pokud zjistíte, že vám nějaká položka chybí, obraťte se na svého dodavatele, který vám poskytne pomoc. 

 

Položka Množství 

Řezací plotr 1 

Stojan (jen pro verze dodávány se stojanem) 

• 2x T-podstavec 

• 1x nosník 

• 20x šrouby 

• 1x imbus šroubovák M5 

• 1x návod na složení stojanu 

1 

Komponenty dodávány s plotrem 

 

Položka J5-183/132/101 J5-61 (LX) J5-61LXE 

Uložení držáku role (2 ks) ANO ANO  

Držák role (2 ks) ANO ANO  

Vodící svěrky držáku role (4 

ks) 
ANO ANO 

 

Podpora držáku role (2 ks) ANO ANO  

Imbus šroubovák M6 (1 ks) ANO ANO  

Návod na držák role  ANO  

Imbus šroubovák M5  ANO  

Podpora držáků role (2 ks)  ANO  

4x plastické nožičky  ANO  

4x M4 šrouby  ANO  

12x M6 šrouby  ANO  

Imbus šroubovák M4  ANO  

Set základny rolí (2 kusy)   ANO 

 

 

1 

Příslušenství 

• 1x napájecí kabel 

• 1x datový kabel (USB kabel: 3 metry) 

• 1x ethernetový kabel (neobsahuje JG-LXE) 

• 1x držák nože 

• 1x řezací nůž (vložený v držáku nože) 

• 1x bezpečná čepel 

1 
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• 1x řezací podložka pro vinylové řezání 

• 1x pinzeta 

• 1x promise card (neobsahuje JG-LXE) 

  

1.3 Vlastnosti řezacího plotru 
Následující jsou hlavní vlastnosti řezacího plotru Jaguar V. 

 

• Trojité propojení řezacího plotru s počítačem poskytuje vysokou flexibilitu 

• Až 600 gramů přítlak 

• Až 1500 mm/sec rychlost řezání (při 45°) 

• Garantované vedení média 10 metrů 

• Uživatelsky přívětivý kontrolní panel 

• Média koš (volitelná položka) 

• Optický systém druhé generace pro ořez 

 

1.4 Pohled na stroj 
1.4.1 Pohled zepředu 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

Posuvný válec: posouvá fólií 

vpřed a vzad během řezání 

Držák nože: vykonává 

řezání pomocí řezáku nože 

a perem s AAS modulem. 
Kontrolní panel: obsahuje 

14 tlačítek a 1 LED a 1 

LCM tlačítko. 

Odřezová drážka: ke 

snadnému odříznutí média 

po řezání 
Deska: zajišťuje plochu při 

řezání a posun média Pravítko: médium 

můžeme založit pomocí 

vodících značek 

Řezací páska: chrání stroj 

i nůž při řezání. Je 

vyměnitelná. 
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1.4.2 Pohled zezadu 
 

 

 
 

 

 

 

 

 

 

  

Kladky: drží 

médium při řezání 

Páka přítlačných kladek: 

zvedná nebo pokládá 

přítlačné kladky. 
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1.4.3 Pohled na celý plotr 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Držák k uložení fólie: 

umožňuje snadné odvíjení 

fólie 

Kolečka s drážkou: udržují 

roli na místě, aby se při 

řezání nepohnula 

Nosník stojanu: 

zpevňuje tělo 

stojanu 

Podpora držáku role: 

udržuje držák role 

T – stojan: drží 

celý plotr 

T – stojan: drží 

celý plotr 



 12 

1.4.4 Pohled z levé stany 
 

 
 

 

 

 

 

 

 

1.4.5 Pohled z pravé strany 
 

 

 

 

 

 

 

 

  

AC napájecí konektor: slouží 

k zasunutí napájecího kabelu  
Jistič – 3 ampéry Vypínač/zapínač 

Sériové připojení 

(RS232C): slouží 

k připojení plotru 

k počítači prostřednictvím 

sériového kabelu  

Ethernetové připojení: 

Slouží k připojení 

řezacího plotru k místní 

síti. 

USB připojení: slouží 

k připojení řezacího 

plotru k počítači 

prostřednictvím USB 

kabelu. 
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2. Instalace 
 

2.1 Opatření 
 

Prosím, přečtěte si pozorně následující opatření před instalací řezacího plotru. 

 

Poznámka 1: 

• Ujistěte se, že před instalací plotru je plotr vypnutý. 

• Při manipulaci se strojem buďte opatrní a držte stroj pevně, abyste předešli zraněním 

a poškozením stroje. 

 

Poznámka 2: Vybrání správného místa pro řezací plotr 

• K přístroji by měl být snadný přístup ze všech stan. 

• Poskytněte dost místa pro přístroj, příslušenství a doplňky. 

• Zajistěte stabilní pracovní prostředí bez nežádoucích vibrací. 

• Teplota pracoviště musí být mezi 5 a 40 °C (41-104 °F). 

• Zajistěte relativní vlhkost prostředí v rozmezí 30-70 %. 

• Chraňte přístroj proti prachu a silnému proudění vzduchu. 

• Chraňte přístroj proti slunci nebo silnému světlu. 

 

Poznámka 3: Zapojení 

 

Zkontrolujte konektor napájecího kabelu a zásuvky, zda se shodují. Pokud ne, kontaktujte svého 

dodavatele. 

 

• Zapojte napájecí konektor do zásuvky. 

• Zapojte napájecí konektor do řezacího plotru. 

 

Poznámka 4: Utahování nebo povolování šroubů pomocí šroubováku 

 

Ať už se jedná o ruční nebo elektrický šroubovák, dbejte na to, abyste při utahování nebo povolování 

šroubů nepoužívali nadměrný kroutící moment. Při utahování nebo povolování šroubů do železa a 

nerezové oceli se řiďte následující tabulkou standardních utahovacích momentů šroubů, šrouby z jiných 

materiálů nejsou zahrnuty. 

 

Průměr šroubu 
Hodnota točivého momentu (kgf-cm) 

Norma točivého momentu pro materiály s vysokou tvrdostí 

M3 6 

M4 16 

M5 30 

M6 50 
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2.2 Stojan & flexibilní držák role (pro J5-101 (LX)/ 132(LX)/ 183LX 
Krok 1: 

Zkontrolujte všechno příslušenství v krabici: 

• 1 set obrub držáku role (2 kusy) 

• 1 set držáku role (2 kusy) 

• 2 kusy základních nosníků 

• 2 kusy postranních nosníků 

• 1 kus nosníku 

• 2 kusy podpory držáku role 

• 20 kusů šroubů M6 

• 1 kus L-imbus šroubovák 

• 1 kus návodu na sestrojení stojanu 

 

Krok 2: 

• Vyndejte tělo řezacího plotru a 

příslušenství z krabice. 

• Umístěte boční příčku na základní 

příčku a uchopte pomocí dvou šroubů 

 

 

Obrázek 2.2-1 

 

Prosím, dejte pozor na pozici základního nosníku a koleček (viz obrázky níže). 

 

 

 

 

 

 

 

 

 

 

 

Obrázek 2.2-2        Obrázek 2.2-3 
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Krok 3: 

Umístěte nosník stojanu vzpřímeně na T – stojany a následujte části 1. a 2. pro sestavení. Vložte šrouby 

do děr a zašroubujte je pevně. Viz obrázek 2.2-4 a Obrázek 2.2-5. 

 

 
Obrázek 2.2-4        Obrázek 2.2-5 

 

Krok 4: 

Umístěte nosník stojanu vodorovně na část 1. a vložte šrouby do děr a pořádně je utáhněte jako na 

obrázku 2.2-5 a poté celkový pohled na stojan bude jako na obrázku 2.2-4. 

 

Krok 5: 

Vyndejte řezací plotr z krabice. Přemístěte se pod plotr, potom vsuňte šrouby do děr na spodní části 

plotru a utáhněte, jako je na Obrázku 2.2-6. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Šrouby 

 

Obrázek 2.2-6 
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Krok 6: 

Vsuňte podpěru držáku role se šrouby do stojanu a utáhněte šrouby jako na Obrázku 2.2-7. Měli byste se 

rozhodnout nad pozicí podpěry držáku role, máte možnost vsunout šrouby do různých děr. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Obrázek 2.2-7 

 

Krok 7: 

Umístěte dva držáky role do mezer podpěry držáku role. (Obrázek 2.2-8) 

 
 

Obrázek 2.2-8 

 

 

  

3 šrouby 

Držák role  
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Krok 8 

Otočte cca třikrát šroubem proti směru hodinových ručiček po rozbalení držáku role (obrázek 2.2-9). 

 
Obrázek 2.2-9 

 

Krok 9 

Vložte konec držák role do levého držáku role bez tlumící klapky a vložte konec držáku role do pravého 

držáku role s tlumícími klapky (Obrázek 2.2-10). 

 
Obrázek 2.2-10 
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Krok 10: 

Utáhněte šroub na kladce dokud není pevně připojena k držáku role. (Obrázek 2.2-11). 

 

 
    Obrázek 2.2-11 

 

Krok 11: 

Na závěr, celkový pohled na řezací plotr a stojan bude vypadat jako na Obrázku 2.2-12. 

 

 
     Obrázek 2.2-12 

 

 

Krok 12: 

Pro návod založení média prosím nalistujte kapitolu 4.1. 
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2.3 Upevnění USB kabelu 
 

Upevnění USB kabelu pouze pro stojany, který mají držák role. 

 

Krok 1: Vložte pásku pro upevnění kabelu do horní dírky podložky zdola nahoru. 

        Touhle stranou nahoru 

 

Krok 2: Vložte USB kabel do pásky pro upevnění a utáhněte. 

  
 

Krok 3: Vložte konec pásky do dolní dírky podložky. 

  
 

 

 

 

 

 

  



 20 

Uvolnění pásky: Vytáhněte konec pásky -> zatáhněte za uvolňovací kolík -> uvolněte pásku 

 

 Vytýhněte konec pásky 

 Zatáhněte za uvolňovací kolík 

 Uvolněte pásku 
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2.4 Systém podpory pracovní plochy [pro J5-61(LX)] 
 

Krok 1:  

Prosím zkontrolujte následující předměty, které se nacházejí v krabici: 

• 1x set uložení držáku role (2 ks) 

• 1x set držáku role (2 ks) 

• 1x set vodící svěrky držáku role (4 ks) 

• 1x set podpěry držáku role (2 ks) 

• 1x set podpěry pracovní plochy (2 ks) 

• 4x ks plastických nožiček 

• 4x šrouby M4 

• 12x šroubů M6 

• 1x M4 L-imbus šroubovák 

• 1x M5 L-imbus šroubovák 

• 1x M6 L-imbus šroubovák (pro úpravu šroubů držáku role) 

• 1s Instalační průvodce pro držák role 
 
 

Krok 2:  

Vložte 4 plastické nožičky pod podpěru držáku role a vsuňte do nich M4 šrouby a utáhněte je M4 L-

imbus šroubovákem (viz obrázek 2.4-1) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Obrázek 2.4-1       Obrázek 2.4-2 

 

 

 

 

Krok 3: 

Umístěte podporu pracovní plochy vedle podpěry držáku role a vsuňte M6 šrouby do podpěry držáku 

role a utáhněte je M6 L-imbus šroubovákem. (viz Obrázek 2.4-2) 

  

Plastická 
nožička  

M4 šrouby 

M4 šrouby 

Podpora 
držáku role 

M6 šrouby 

Podpora 
pracovní 
plochy 

M6 šrouby 

Podpora 
držáku role 
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Krok 4: 

Položte stroj na bok a umístěte podpěry držáku role vedle spodní části stroje. Potom vsuňte šrouby M6 

do děr podpěry držáku role a utáhněte je M6 L-imbus šroubovákem, viz Obrázek 2.4-3. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

Obrázek 2.4-3          Obrázek 2.4-4 

 

 

Krok 5: 

Vložte dva držáky role do mezer podpěry držáku role. (Obrázek 2.4-4). 

 

Krok 6: 

Sestavený systém flexibilní podpěry pracovní plochy bude vypadat jako na Obrázku 2.4-5. 

 

 
Obrázek 2.4-5. 

  

Díry na šrouby M6 šrouby 

Podpěra 
držáku role 

Držák role 
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2.5. Základní odlehčený systém podpory fólií [pro J5-61(LXE)] 
 

Krok 1: Vyjměte základnu rolí. Základna role je opatřena magnety. V závislosti na šířce používaného 

materiálu jej umístěte do vhodné polohy a přímo připevněte základnu role ke stroji. 

 

 
Krok 2: Instalace je hotova 
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2.6. Instrukce o tlumiči kladek 
Otočte kolečko pro nastavení tlumení, jak je znázorněno níže. Číš vyšší je číslo, tím je větší tlumení. 

Nálepka intenzity ukazuje úroveň tlumení (viz obrázky níže). 
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2.7. Instalace nože 
Na obrázku 2.6-1 je zobrazen držák nože. Nůž se vkládá do spodního otvoru držáku a můžete s ním hýbat 

pomocí vysunovací tyčky. Ujistěte se, že Vaše prsty jsou z dosahu špičky nože. 

   

  Obrázek 2.6-1 

Krok 1: 

Vložte nůž do spodního otvoru (viz obrázek 2.6-2). 

 

 

 

 

 

 

 

 

 

   Obrázek 2.6-2        Obrázek 2.6-3 

 

 

Krok 2: 

Ujistěte se, zda je nůž zasunutý na doraz. (Obrázek 2.6-3) 

 

Krok 3: 

Pomocí knoflíku pro nastavení hloubky nastavte optimální vysunutí nože 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Knoflík pro nastavení 

hloubky 

Vnější prstenec 

Vysunovací tyčka 

Tip: 
Optimální vysunutí” znamená, že délka 

vysunutí nože je o něco málo větší (zhruba 

o 0,1 mm) než je tloušťka svrchní vrstvy 

fólie. (To znamená, že když je tloušťka 

svrchní vrstvy média 0,5 mm, tak délka 

vysunutí nože je okolo 0,6 mm). Cílem je 

vysunou nůž tak, aby prořízl svrchní vrstvu 

a lehce poškrábal vrstvu podkladní. Zbytek 

se přesněji doladí nastavením přítlaku. 
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Krok 4: 

Vložte držák nože do posuvného držáku nástroje. Prosím, věnujte pozornost vnějšímu prstenci na držáku 

nože, musí volně zapadnout do drážky v držáku nástroje (Obrázek 2.6-4), potom zajistěte držák nástroje 

upínacím šroubem (Obrázek 2.6-5). 

 

 

 

 

 

 

 

 

 

 

 

 

Obrázek 2.6-4        Obrázek 2.6-5 

 

Krok 5: 

Pro vyjmutí nože použijte opačný postup. 

 

Krok 6: 

Pro vysunutí nože z drážky, stiskněte vysouvací tyčku. 

 

Upozornění: 

Nůž se po krátké době lehce ztupí – zapracuje. Takto vydrží dlouho – po dobu životnosti. Doba 

životnosti uváděná u nožů je pouze orientační, záleží na řezaném materiálu, typu nože vzhledem k řezané 

grafice a nastavení. Konec životnosti se projeví zhoršenou kvalitou řezu. Krátce, nouzově může pomoci 

zvýšení hodnoty přítlaku. Jakmile je nůž jednou ztupen, nezajišťuje již přesné řezání a měl by být vyměněn 

za nový. Nůž je spotřební materiál a měl by být vyměňován tak často, jak je nutné k zajištění kvality řezu. 

Kvalita nože silně ovlivňuje kvalitu řezu. 
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2.8. Automatická úprava délky nože 
Na Obrázku 2.6-6 je nový držák nože se stupnicí a pohyblivý držák nástroje se značkou. Tento držák 
nože automaticky detekuje délku nože a ukazuje, jak knoflík musí být nastaven na LCM. 

 
 
 

 
 
 
 
 
 
 
 

 
 
 

 
 
 
 
 

Obrázek 2.7-1        Obrázek 2.7-2 

Na stupnici je 10 částí a každá část představuje 0,5 mm, umožňující úpravu délky nože od 0,00 mm do 

5,00 mm (Obrázek 2.7-1). 

 

Následujte tyto kroky pro nastavení délky nože: 
 

1. Předtím než začnete seřizovat délku nože, mějte nůž na nule 
 

2. Zarovnejte jednu z drážek na stupnici na držáku nože se značkou. 
 

3. Vyberte “Blade Length Adjust” pod “CUT TEST” na LCM displeji, zadejte 
požadovanou délku nože v “Set Length”; nejdříve otestujte držák nože a poté 
otestujte délku nože tím, že zmáčknete ENTER. 

 
Poznámka: Když nastavujete držák nože a také když testujete jeho délku, udržujte držák nože 
ve stejné pozici. 

 
4. Až test držáku nože a test délky nože bude ukončen, displej Vám ukáže, na jaký stupeň 

(jednotka hodnoty následující “CW” nebo “CCW” je “kruh”) a jaký směr [CW (po 
směru hod. ručiček) nebo CCW (proti směru hod. ručiček)] byste měli nastavit na 
otočném knoflíku. EG, Turn CW 0.5 Vám říká, že byste měli otočit knoflík o polovinu 
kruhu po směru hod. ručiček. (Obrázek 2.7-3, Obrázek 2.7-4). 

Stupnice 1 bod 

Značka 
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  Obrázek 2.7-3                                          Obrázek 2.7-4 

 

5. Displej Vám ukáže „Adjustment completes“, když hodnota na displeji bude 0, délka nože 

je perfektní, žádné další nastavení nejsou potřeba. Stiskněte „Enter“ pro dokončení 

nastavení a nyní můžete začít řezat. 
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2.9. Připojení řezacího plotru 
 

Řezací plotr komunikuje s počítačem pomocí USB (Universal Serial Bus), Sériovým portem (RS-232C) 

nebo Ethernetovým portem. Tato kapitola Vám ukáže, jak připojit plotr k počítači a jak nastavit řezací 

plotr. 

 

Poznámka: Pokud jste připojili plotr pomocí USB kabelu, tak je automaticky zakázán sériový port. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.9.1. USB rozhraní 

Jaguar V modely mají zabudované USB propojení, které je založeno na Universal Serial Bus 

Specifications Revize 2.0. (Plná rychlost). 

 

2.8.1.1 Připojení GCC plotru 

1. Zapněte plotr. 

2. Zapojte USB konektor do plotru, potom se USB naistaluje automaticky. Bude to trvat několik 

minut, než USB najde přístroj. Prosím, NEODPOJUJTE USB kabel před tím, než bude 

instalace dokončena. 

3. Můžete 2x kliknout na USB ikonu na liště, abyste si byli jistí, že USB nalezlo zařízení. 

 
 

2.8.1.2. Instalace driveru 

Použijte USB jeden-klik instalaci pro rychlou instalaci driveru. Použijte jednoduché kroky níže, pro 

nastavení driveru. 

Upozornění: Pokud používáte operační systém Windows 8/7/Vista/XP/2000, ujistěte se, že jste se 

přihlásili do účtu „Administrator“. 

 

Krok 1: Navštivte stránky GCC a přejděte do sekce “SUPPORT” manuálu, driveru a softwaru 

(https://www.gccworldnew.com/download.php). 

Sériový port (RS232C) – použijte pro 
propojení řezacího plotru a počítače 
pomocí sériového kabelu.  

USB – použijte při propojení plotru a počítače 
pomocí USB kabelu.  

Ethernet– použijte při propojení plotru a 
počítače na místní síť. 

https://www.gccworldnew.com/download.php
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Krok 2: 

Můžete použít funkci vyhledávání nebo přímo vyberte model plotru, který chcete naistalovat. 

 

 

 
Stáhněte ovladače podle typu připojení 
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Krok 3: Rozbalte soubor a dvojím kliknutím na driver.exe spusťte instalaci ovladače a AAS plug-in. 

 
Krok 4: 

Pokud jste uživatel Windows 7 a vyšší verze prosím klikněte na červená slova pro instrukce, jak 

deaktivovat aktualizace Windows a umožnit úspěšnou instalaci driveru. Poté klikněte na OK. 

 
 

Krok 5: 

Ujistěte se, že plotr je zapnutý a připojený k PC pomocí kabelu, poté klikněte na OK. 
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Krok 6: 

Potvrďte, že jste zavřeli všechny spuštěné aplikace před začátkem instalace a klikněte na OK. 

 
 

Krok 7: Pokud chcete instalovat AASII VBA na CorelDRAW a Adobe Illustrator, zavřete CorelDRAW 

a Adobe Illustrator a klikněte na „Install“. 

 

 
 

Krok 8: 

Zkontrolujte zprávu o instalaci a potvrďte CorelDRAW a AI verzi a poté klikněte na OK. 

 

 
 

Poznámka: 

(1) Pokud se ovladač instaluje podruhé, bude uživatel vyzván, zda druhá instalace je potřeba. 

 
 

(2) Pokud uživatel zvolí ano, druhá instalace bude instalována. 
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(3) Pro uživatele, kteří upgradovali Adobe Illustrator nebo CorelDRAW. Prosím, jděte na stránku 

AAS Installer v okně Printer Properties a klikněte na „Install“, pro umožnění instalace poslední 

verze GCC AAS Plug-in. 

 

 
 

2.8.3.3 Odinstalování driveru 

Nejdříve musíte odstranit předešlou nainstalovanou verzi driveru na Vašem PC, než budete instalovat 

novou verzi. Prosím, postupujte podle kroků níže. 

Krok 1: Jděte do okna Ovládací panely -> Hardware a zvuky -> Zařízení a tiskárny. Pravou myší klikněte 

na cutter a vyberte „Odebrat zařízení“. 

 



 34 

 

 

Krok 2: Po odstranění jednotky, klikněte na jakoukoliv tiskárnu a vyberte „Vlastnosti tiskového 

souboru“ (pro Win 7 a výše). 

Nebo klikněte do prázdna a vyberte „Vlastnosti tiskového souboru“ (pro Win XP). 

 

 
 

 

Krok 3: Vyberte stránku driveru 
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Krok 4: Vyberte na model a klikněte na „Odstranit“ 

 

 
 

Krok 5: Vyberte „Remove drive and driver package“ a klikněte na OK.

 
 

Krok 6: Klikněte na YES, poté na „Delete“ a „OK“ a nainstalovaný driver je zcela odebrán. 
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2.9.2. RS-232 propojení 
 

• Připojení RS-232 (Sériový) Port 
 

 

1. Pro IBM PC, uživatele PS/2 nebo kompatibilní, připojte RS-232C kabel do sériového konektoru 

umístěného na sériovém portu (COM1 nebo COM2) ve Vašem počítači. 

2. Nastavte komunikační parametry (Přenosová rychlost a Data Bity/rovnost), aby 

odpovídaly nastavení softwarového balíku, najdete v kapitole 3 – “Misc” klíč popisu. 

 
!Upozornění: Vypněte plotr před tím, než připojíte RS-232C kabel. 

 

2.9.3. Ethernetové propojení 
Existují dva způsoby, jak pomocí ethernetového propojení můžete řezat na plotru. Pokud řežete pomocí 

GreatCut-S, následujte první způsob. Pokud řežete přes Adobe Illustrator nebo CorelDRAW, následujte 

postup 2. 
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Postup 1 (řezání přes GreatCut-S): 

GreatCut-S je plug-in pro CorelDRAW a Illustrator. (Instalace GreatCut-S – kapitola 3.9.1). 

 

Instrukce pro ethernetové nastavení pro GreatCut: 

1 Otevřete GreatCut-S a vytvořte novou složku a řezací linky. 

 
 

2 Jděte do Nastavení -> Předvolby -> Výstupní zařízení 

 
3 Vyberte model v okně Předvolby – výstupní zařízení 
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4 Vložte IP adresu, kterou jste získali z kontrolního panelu do TCP/ IP. Klikněte na OK. 

   
5 Jděte na Soubor-> Výstup na zařízení pro zkontrolování nastavení. 

  
 

Poznámka: Pokud chcete přidat nový místní zařízení, prosím, jděte na Soubor-> Předvolby -> Výstup na 

zařízení a klikněte na tlačítko na pravé straně Aktuální výstupní zařízení a vyberte Přidat místní zařízení 

(pokud zařízení bylo nainstalováno, ale vy chcete řezat přes jiné zařízení, vyberte Změnit pro nastavení 

IP adresy jiného zařízení). 
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Postup 2: Řezání přes Ethernetový driver 

Část první: 

Krok 1: Připojte port LAN a port Ethernet na řezacím plotru GCC pomocí kabelu RJ45 Ethernet a zapněte 

plotr.  

Krok 2: Stiskněte tlačítko On/Off a poté MISC na kontrolním panelu plotru. 

SPEED FORCE OFFSET

MISC TOOL SELECT DATA CLEAR CUT TEST
ON/OFF 

LINE PAUSE / RESUME ENTER

POWER

 

Krok 3: Jděte na stránku DHCP a vyberte „Enable“ pomocí šipek nahoru a dolu, poté stiskněte Enter. 

 

Krok 4: IP adresa se objeví na obrazovce automaticky. Prosím, zapište si ji. 

 

Krok 5: Stiskněte tlačítko On/Off a jděte na hlavní stránku. 

Část druhá: 

Pokud vytváříte grafiku prostřednictvím aplikace Adobe Illustrator nebo CorelDRAW, postupujte podle 

níže uvedených pokynů. 

Krok 1: Připojte ethernetový kabel k PC a naistalujte driver. Klikněte OK. 

 

Krok 2: Vložte IP adresu, kterou jste získali z kontrolního panelu a vyberte model. 
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Krok 3: Driver je naistalovány. Nyní můžete přímo řezat přes AI nebo Corel DRAW. 

 

 

2.9.4. Přenesení dat 
 

Existují dvě možnosti, jak přenést data z počítače do řezacího plotru. 
 

Možnost 1: S řádným nastavením připojení, mohou být data přenesena ze softwaru přímo do 

řezacího plotru. 

Možnost 2: Většina softwarových balení řezacích plotrů jsou schopni napodobit příkazy HP-GL              

   nebo HP-GL/2. 

Pokud soubor je formátu HP-GL nebo HP-GL/2, řezací plotr může přesně přijmout 

data. 

 

2.9.5. Sdílené nastavení tiskového serveru 

 

V „A-PC“, nastavte driver tiskárny jako sdílená tiskárna, poté použijte B-PC pro připojení k A-PC 

tiskárně pomocí internetu. 

 
 

Krok 1: Nastavte driver tiskárny A-PC jako sdílenou tiskárnu. (Pravou myší klikněte na ikonu tiskárny, 

vyberte Vlastnosti tiskárny. Klikněte na Sdílet tuto tiskárnu). 
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Krok 2: Klikněte na Upřesnit, poté vyberte možnost Tisknout přímo na tiskárnu. 

 
 

Krok 3: Pošlete práci do stroje, abyste zjistili, zda je A-PC propojený se strojem. 

    
 

Krok 4: Aktivujte driver A-PC tiskárny z B-PC Network 

      
 

Krok 5: Pravou myší klikněte na ikonu tiskárny a vyberte Propojit pro propojení A-PC tiskárny. 
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2.10. Instalace softwaru 
 

2.10.1. Instalace softwaru GreatCut-S 
 

Krok 1: Navštivte stránky http://gccf.gcc.com.tw/gccclub/login.aspx a přihlašte se do GCC klubu. 

 
 

nebo si vytvořte nový účet v GCC klubu. Klikněte na „I agree“, vyplňte požadované informace a 

klikněte na „Submit“, čímž se zaregistrujete. 

 

 

 
 

 

 

http://gccf.gcc.com.tw/gccclub/login.aspx
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Měli byste dostat email s aktivačním linkem. Pro aktivaci klikněte na link. 

 

 
 

Krok 2: Navštivte GCC Club a klikněte na „GreatCut-S voucher code“ na levé straně lišty. 

 
 

Krok 3: Vložte voucher kód a klikněte na „Submit“ 
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Krok 4: Dostanete GreatCut-S sériové číslo. 

 
Krok 5: Navštivte stránky https://www.gccworld.com/download.php, klikněte na kategorii Vinyl Cutter 

a vyberte váš model plotru. 

 

 

 
 

https://www.gccworld.com/download.php
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Krok 6: Stáhněte GreatCut-S, čímž zahájíte instalaci. 

 
 

Krok 7: Klikněte na Next, zaklikněte „Launch GreatCut-S“ a klikněte na tlačítko „Finish“, čímž 

dokončíte instalaci. 

   
 

Krok 8: Zapněte GreatCut-S a klikněte na tlačítko „Activate..“. Ujistěte se, že jste připojeni k internetu. 

  
 

Krok 9: Vyplňte do požadovaných políček Jméno a Sériové číslo. Poté klikněte na tlačítko OK, čímž 

dokončíte aktivaci. 
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Krok 10: GreatCut-S je připraven k použití. 

 
Poznámka: Pokud k výstupu grafiky použijete zkušební verzi, což znamená, že nezadáte výše uvedený 

softwarový klíč k aktivaci softwaru, budou v návrhu vyříznuty dva řádky navíc, proto se před realizací 

řezacích úloh ujistěte, že je software aktivován. 

 

2.10.2.  Ruční aktivace software 

 

Pokud počítač připojený k plotru nemá připojení k internetu, můžete alternativně použít možnost aktivace 

ručně =„Activate manually“ a vložit aktivační kód pro spuštění softwaru ručně. Pro získání aktivačního 

kódi však budete potřebovat počítač s přístupem k internetu podle níže uvedených pokynů. 

 

Krok 1: Zaškrtněte možnost „Activate manually“ a měly by se objevit další dvě pole k vyplnění: „Site 

Code“ a „Activation Code“. Pole Site Code bude předvyplněné a nemůže být změněn. 

 
 

Krok 2: Navštivte tuto adresu: https://craftedge.com/activation/greatcut/. Zadejte jméno, sériový 

(softwarový klíč) a site kód. 

https://craftedge.com/activation/greatcut/
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Krok 3: Klikněte na tlačítko „Generate Activation Code“, čímž se vám v části Activation Code zobrazí 

váš aktivační kód. 
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Krok 4: Zkopírujte a vložte aktivační kód zpátky do dialogového okna GreatCut-S a dejte OK. 

 
 

Krok 5: Klikněte na tlačítko OK a GreatCut-S je připraven k použití. 

 
 

2.10.3.  Opětovná instalace softwaru GreatCut-S 

Pokud změníte počítač, měl by se deaktivovat software GreatCut-S a znova naistalovat na nový počítač. 

 

Přejděte na položku „Deactivate..“ v části nápovědy „Help“ a potvrďte pomocí tlačítka OK. Poté znovu 

nainstalujte software podle pokynů výše a použijte stejný aktivační kód. 
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2.10.4.  Resetování sériového kódu GreatCut-S 

Pokud potřebujete znovu nainstalovat software z důvodů problémů, jako je porucha počítače, kdy jste 

nemohli nejprve deaktivovat kód v počítači. Navštivte https://craftedge.com/activation/deactivateGC.php 

pro resetování sériového čísla. 

 

https://craftedge.com/activation/deactivateGC.php
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3. Kontrolní panel 
Tato kapitola Vám popíše tlačítka pro operaci s LCM menu. Když je řezací plotr připraven k použití, 

jak jsme popsali v kapitole 1 a 2, všechny funkce mají výchozí nastavení. 

3.1. Dotykový panel 

SPEED FORCE OFFSET

MISC TOOL SELECT DATA CLEAR CUT TEST
ON/OFF 

LINE PAUSE / RESUME ENTER

POWER

 
LCD dotykový panel na Jaguar V 

 
 

Klávesa 
 

Funkce 
 

LCD displej 
 

Zobrazuje různé funkce a zprávy při komplikacích. 
 

Power LED 
 

Svítí, pokud je zapnuto. 
 

Tlačítka se šipkami 
 

Slouží k vedení média nebo ke změnám v nastavení. 
 

ENTER 
 

Slouží k nastavování položek, k registrování právě předcházející vložené 

hodnoty 
 

PAUSE/RESUME 
 

Současně zastaví proces anebo v něm pokračuje. 
 

ON/OFF LINE 
 

Slouží k zastavení řezání nebo v něm pokračuje. 
 

OFFSET 
 

Slouží k nastavení hodnoty offsetu. 
 

FORCE 
 

Slouží k nastavení přítlaku. 
 

SPEED 
 

Slouží k nastavení rychlosti řezání. 
 

CUT TEST 
 

Provede Cut Test- test řezání, Repeat- zopakování posledního řezu 

 DATA CLEAR  Pro k vymazání předchozích dat 

 TOOL SELECT   Výběr nástroje a jeho nastavení 

 MISC  Slouží k nastavení funkcí 
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3.2. Menu v online módě 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Jaguar V 
Firmware:    Copyright: 

 

Place Media And Then 
Lower Down The Lever 

Roll       Edge      Single  

 Key   Key   Key 

Sizing Media Width  
Lever Up To Abort 

 

Sizing Media Length  
Lever Up To Abort 

拨杆 

Pause  Setup   Resume 

 

S--- F----- O----  
L-------- W-----T1M 
 

 
Sending data 

 

[PAUSE ] 

 [ FORCE] 

 
Force:80 gf 
          OK:ENTER 
 

use    to select; [ENTER] to enable the 
setting 

[ SPEED ] 
key ] 

Speed:       72 cm/s 

Select:    OK:ENTER 
 

Up Speed:   72 cm/s 
Select:       OK:ENTER  
 

Quality:      normal 
Select:      OK:ENTER  

 

[ OFFSET ] 

 
Offset: 0.275 mm 
          OK:ENTER 

 [ DATA CLEAR ] 

 
Clear Data Memory 
N:ONLINE     OK:ENTER      

 
[TOOL SELECT ] 

 1S:72   F:80  O:0.275 M 
Select:        OK:ENTER 
 

Set Smoothing Cut 

Select:     OK:ENTER  

 

OverCut:      0.00mm 
Select:        OK:ENTER 
 

Pouncing      0 mm 
Select:       OK:ENTER 

 

Top menu 

 

Set Tangential Mode 

Select:     OK:ENTER 

 

use     to select 

 

Cutter 
LCM Version- - - 

 

Up Accel.:    Medium 
Select:       OK:ENTER  
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3.3. Menu v offline módě 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Offline For System Setup 

[ DATA CLEAR ] 
CLEAR ] Clear Data Memory 

N:ONLINE     OK:ENTER     

 

    move origin  M  
X:             Y: 

[         ] 

 

[ FORCE] 

 
5~600 with an increment of 5(gram force) 

 
Force:80 gf 
          OK:ENTER 
 

[ OFFSET ] 

 Offset: 0.275 mm 
          OK:ENTER 

 

0.000~1.000 with an increment of 0.025(mm) 

Draft, Fair, Normal, Fine, Small Letter 
 

Speed: 3~153 with an increment of 
3(cm/s) 

[ SPEED ] 

UP Speed:   72 cm/s 
Select:       OK:ENTER 
 

UP Speed: 3~153 with an increment of 3(cm/s) 
 

Quality:       Normal 
Select:       OK:ENTER 

 

Up Accel.:       Medium 
Select:       OK:ENTER 

 

High, Medium, Low 
 

Speed:       72 cm/s 
Select:       OK:ENTER 
 

Square Cut 
Select:         OK:ENTER 

[CUT TEST ] 

 

Repeat AAS Job 
Select:         OK:ENTER 

Pattern: Cross, Arrow 
Pattern Setting  
Select:         OK:ENTER  

Pattern: Arrow 
Change:      OK: ENTER 

Ratio: 100%, 200%, 300%, 400% 
Ratio Setting  
Select:         OK:ENTER  

Ratio:               100% 
Change:       OK: ENTER 

Blade Length Adjust  
Select:         OK:ENTER  

Set Length    0.00mm          
Change:       OK: ENTER 

Test Blade Holder           
OK: ENTER 

Test Blade Length           
OK: ENTER 

Redo Jobs in Memory 
Select:         OK:ENTER 

Recut          #1 
Select:         OK:ENTER 

Copy           #1 
Select:         OK:ENTER 

Turn CW           O Turn        
N:ONLINE     OK: ENTER 

Adjustment completes          
OK: ENTER 

Recut number: 0-99 

Copy number: 1-999 

After sending AAS job 
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Offline For System Setup 

OverCut: 0.00~1.00mm with an 
increment of 0.05mm 

[ TOOL SELECT] 

1S:72  F:80   O:0.275 M  
Select:        OK:ENTER 
 

OverCut:  0.00mm 
Select:       OK:ENTER 
 

Set Smoothing Cut 
Select:       OK:ENTER 
 

Set Tangential Mode 
Select:       OK:ENTER 
 

Pouncing          0 mm 
Select:       OK:ENTER 
 

Panel Setup 
Select:       OK:ENTER 
 

Pouncing: 0~200mm with an 
increment of 1mm 

Factory Default ? 
Select:       OK:ENTER 
 

[ MISC] 

 

Enabled, Disabled 

 

Auto Unrolled Media 
Select:       OK:ENTER 
 

Rear Paper Sensor 
Select:       OK:ENTER 
 

Enabled, Disabled 

 

Vacuum 
Select:       OK:ENTER 
 

Enabled, Disabled 

 

First Back To Origin 
Select:       OK:ENTER 
 

DHCP 
Select:       OK:ENTER 
 

Enabled, Disabled 

 

IP Address 
Select:       OK:ENTER 
 

IP Address set, Submask set, 
Gateway set 

 
MAC Address 
 00:CF:52:72:03:01 

 
Enabled, Disabled 

 

AAS Offset 
Select:       OK:ENTER 
 

Paper Saving Mode 
Select:       OK:ENTER 
 

Set communication 
Select:       OK:ENTER 
 

Select Language 
Select:       OK:ENTER 
 

Select Unit 
Select:       OK:ENTER 
 

Scale Length 
Select:       OK:ENTER 
 

Scale Width 
Select:       OK:ENTER 
 

Image Scale Length 
Select:       OK:ENTER 
 

Image Scale Width 
Select:       OK:ENTER 
 

Firmware    x.x.xx 
FPGA: xx.xx 

 

Both Expanded Mode, Length Expanded Mode, 

Width Expanded Mode, Both Unexpanded Mode, 

 

English, Francais, Türkce, Polski, Ingles, 
Japanese, Deutsch, Italian, Espanol 

 
Metric (cm/g), Unit (inch/ g),  
Unit (cm/ oz), English (inch/ oz) 
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3.4. Položky menu 
Nabídka nebo tlačítko Funkce Nastavení Výchozí 

nastavení 

--- Média sizing --- 
Roll Změří šířku média Max. délka média 150 

metrů 
 

Edge Změří šířku a posune médium tak, aby byl přední senzor nezakrytý. Max. délka média 150 

metrů 
 

Single Změří šířku a délku. Max. délka média 

10 metrů. 
 

--- POWER --- 

 Zobrazuje status plotru.   

[ Šipky ] 

 1. K posouvání po osách. 

2. K výběrům funkcí v menu. 
  

[ ENTER ] 

 1. Zobrazené parametry automaticky uloží. 

2. Pro nastavení nového počátku. V off-line módu, posuňte držák 

nože do požadované polohy pomocí šipek a poté stiskněte ENTER 

pro nastavení nového počátku. 

  

[ PAUSE/RESUME ] 

 Tlačítko zastaví práci a po opětovném zmáčknutí tlačítka 

PAUSE/RESUME, práce pokračuje. 
  

[ ONLINE/OFFLINE ] 

 1. Přepíná mezi online a offline módem. 

2. Slouží ke stornování řezání bez možnosti návratu. 
  

[ OFFSET ] 

 Nastavení hodnoty offsetu pro řezání. 0.000~1.000mm 0.275mm 

[ FORCE ] 

 Pro nastavení přítlaku řezaní. 

Pro Jaguar V, když přítlak přesáhne 450g, maximální rychlost by 

měl být 15cm/sec a kvalita řezání – Small Letter (0,2g) a zatímco 

přítlak je 300g-449g, maximální rychlost by měla být 30 cm/sec a 

kvalita řezání – Fine (0,5g) 

 

5~600gram; 

5 gram/per step 
80 gram 

[ SPEED ] 
Speed K nastavení rychlosti řezání. 3~153cm/s; 

(kroky po 3cm/s) 
72cm/s 

Up Speed K nastavení rychlosti při přejezdech. 3~153cm/s; (kroky 

po 3cm/s) per step 
72cm/s 

Cutting Quality K nastavení kvality řezání. 

Pokud řežete malá písmena, zvolte “Small letter”. 

Pokud chcete řezat rychle, zvolte “Draft”. 

Pro normální řezání zvolte “Normal”. 

Draft, Fair, 

Normal, Fine, 

Small Letter 

Normal 

Up Accel. Pro nastavení nebo úpravu akcelerace, zatímco se držák nástrojů 

pohybuje z konečného bodu do startu v horizontálním pohybu. 

High, Medium, 

Lox 

Medium 
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[ CUT TEST ] 
Square Cut Spustí test řezání v současné poloze vozíku. 

Pro více informací jak nastavit rychlost a přítlak můžete přejít 

na kapitoly 4-3. 

  

Repeat AAS 

Job 

Pro opakování úloh AAS automaticky bez nutnosti operace na 

počítači. Prosím, poznamenejte si, že tato funkce se používá 

zejména pro mód jednoho papíru. Prosím, zajistěte nový kus 

materiálu, který si přeje použít pro tuto funkci a vložte ho na 

původní registrační značky před zahájením. Když první AAS 

práce opakuje dokončení, bude uživateli nabídnuta možnost 

“Repeat AAS Job Again”, prosím zmáčkněte ”Online/Offline” pro 

navrácení do hlavního menu. 

   

Pattern Setting 

(=nastavení 

schématu) 

Poskytuje dvě schémata pro test řezání 

Poznámka: Je doporučeno vybrat “Cross” pokud pracujete 

s tlustým materiálem. 

“Arrow” and 

“Cross” patterns 
“Arrow” 

Ratio Setting Pro nastavení velikosti schématu 100 %, 200 %, 

300 %, 400 % 
100 %  

Blade Length 

Adjust (nastavení 

délky nože) 

Pro nastavení délky nože. 

Poznámka: 

1.   Mějte délku nože na 0 předtím, než začnete nastavovat. 

2.   N e j p r v e  o testujte držák nože a poté otestujte délku držáku 

nože tím, že zmáčknete ENTER. 

3.   Držte držák nože ve stejné pozici, když testujete držák 

nože a délku držáku nože. 

4.   Až test nože a test držáku nože bude ukončen, displej Vám 

ukáže na jaký stupeň (jednotka hodnoty následující “CW” nebo 

“CCW” je “kruh”) a jaký směr [CW (po směru hod. ručiček) 

nebo CCW (proti směru hod. ručiček)] byste měli nastavit na 

otočném knoflíku.EG, Turn CW 0.5 Vám říká, že byste měli 

otočit knoflík o polovinu kruhu po směru hod.ručiček. 

5.   Hodnota displeje bude 0.0, když délka nože bude perfektní, 

žádné další nastavení nejsou potřeba. Budete vyzváni následující 

zprávou: „Adjustment completes and you may start cutting at 

this point“= Nastavení dokončeno, může začít řezat. 

0.00mm-5.00mm 0.00mm 

Redo Jobs in 

Memory 
Chcete-li zopakovat test řezání a úlohy uložené v paměti, 

znovu řežte nebo umožněte kopie testu řezání. 
Recut (number of 

jobs: 1-99) 

 
Copy (number of 

jobs: 1-999) 

Recut 

[ DATA CLEAR ] 

 Vymaže krátkodobou paměť. (buffer)   
[ TOOL SELECT ] 

Nastavení 

vyhlazování 
K povolení vyhlazování  Enable 

Over Cut Umožňuje přeřezávání okrajů začátku a konce čáry úseku. 0.00mm-1.00mm 

0.05mm/per step 
0.00mm 

Nastavení 

tangenciálního 

módu. 

Umožňuje tangenciální techniku řezu pro silnější typy médií, řezání 

drobného textu. Pozn.: Mód je vypnut, pokud offset je nastaven na 

hodnotu 0,00mm 

 Enable 
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Pouncing 

(děrování) 
Tato funkce se používá k vytvoření vzorku preformace společně 

s tužkou nebo křídou k děrovací sadě: Vzorek Vám umožní přenést 

obrázek na povrch kvůli malování nebo vystřihování. Před 

samostatným děrováním je třeba založit magnetický děrovací pásek 

na plochu ochranného pásku nože. To ochrání ochranný proužek 

během děrování. Založte děrovací nástroj do vozíku nástroje 

(posuvné hlavy) řezacího plotru a bezpečně utáhněte šroubem.  

*Nástroje pro děrování je volitelná položka 

0~200mm 0mm 

Panel Setup 

(nastavení 

panelu) 

Akceptování příkazů: 

K nastavení možnosti posílání parametrů (přítlak, rychlost, 

kvalita a offset) přes software. 

  

Pouze kontrolní panel: 

Pro přijímání příkazů o přítlaku, rychlosti, kvality řezu a offsetu, 

pouze prostřednictvím kontrolního panelu. 

  

Factory Default 

Zpět výchozí 

hodnoty 

Vrátí hodnoty v menu na tovární nastavení.   

[ MISC ] 
Auto Unrolled 

Media 

(Automatické 

odvíjení média) 

Tato funkce je vhodná pro vyhnutí se mačkání papíru a rozbití 

morotu a to díky automatickému odvíjení fólie (50 cm a více) 

přes řezání, když je funkce nastavena na „Enable“ 

*Pokud je délka role menší než 2m nebo pokud je role lehká, 

doporučujeme nastavit „disable“ 

*Auto unroll se projeví pouze při volbě roll/edge při načítání 

média. 

 Enable 

Vacuum 

 
Pomáhá vylepšit sledování a přesnost řezu zapnutím ventilátorů. 

Pokud vypnete vakuový systém, větráky zůstanou neaktivní 

během řezání nebo kreslení. 

Enable, Disable Enable 

AAS Offset K nastavení AAS offsetu. 

Víc detailů najdete v “5.3 Printer Test”. 

  

First Back to 

Origin 
Enable- ušetří čas při opakování 

Když je zaškrtnuto „Enable“, nůž se neposune na předchozí 

počáteční bod, zatímco „Disable“ se tam přesune. 

Enable 

Disable 

Enable 

Paper Saving 

Mode 
4 módy pro ušetření média: 

1. Length expanded mode 2. Width expanded mode 

3. Both expanded mode 4. Both unexpanded mode 

 Length 

expanded 

mode 

Set 

Communication 

 

K nastavení komunikace mezi počítačem a plotrem. 

Baud Rate- k určení rychlosti přenosu dat. 

Data Bits- k nastavení velikosti 1 blok. 

Parity- kontroluje, jestli data dorazily v pořádku. 

9600, n, 7, 1, p 9600pbs, 7 Bits with NO Parity 

9600, o, 7, 1, p 9600pbs, 7 Bits with ODD Parity 

9600, e, 7, 1, p 9600pbs, 7 Bits with EVEN Parity 

9600, n, 8, 1, p 9600pbs, 8 Bits with NO Parity 

9600, o, 8, 1, p 9600pbs, 8 Bits with ODD Parity 

9600, e, 8, 1, p 9600pbs, 8 Bits with EVEN Parity 

19200, n, 7, 1, p 19200pbs, 7 Bits with NO Parity 

19200, o, 7, 1, p 19200pbs, 7 Bits with ODD Parity 

19200, e, 7, 1, p 19200pbs, 7 Bits with EVEN Parity 

19200, n, 8, 1, p 19200pbs, 8 Bits with NO Parity 

19200, o, 8, 1, p 19200pbs, 8 Bits with ODD Parity 

19200, e, 8, 1, p 19200pbs, 8 Bits with EVEN Parity 
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Firmware 

Version 
Zobrazí se číslo verze Firmwaru a FPGA kód.   

 

 
Select 

Language 

(nastavit jazyk) 

Na LCM displeji může změnit jazyk na následující: English, 

Spanish, Italian, Deutsch, Japanese, Portuguese, Polish, 

Turkish or French. 

 English 

Select Units 

(Výběr jednotek) 
Poskytuje dvě jednotkové sestavy. cm/s; inch/oz 

cm/oz; inch/gram 
Metrický 

systém 

Image Scale 

Length 
Funkce úpravy korekce měřítka se používá k odstranění nepřesnosti 

délky a šířky, způsobenou tloušťkou média.  

 
Čitatel je skutečná délka a jmenovatl je ideální délka naměřená 

z výsledku. 
Např. linku o délce 500.0 mm následujte tuto proceduru: 

 

1. Použijte levou šipku k nastavení rozsahu, potom použijte tl. 

Horní-dolní šipky k nastavení 500.0 mm, 

2. Odesláním souboru vyřežte požadovanou délku. 

3. Zmáčkněte požadovanou délku a tl., pravé šipky ke změně 

hodnoty délky. 

4. Nakonec stiskněte tl. Horní-dolní šipky ke změne hodnoty 

skutečné délky. 

 500/500 mm 

Imaged Scale 

Width 

Scale Lengh Opravená měřítka, pouze pro údržbu   

Scale Width 

Sizing Setting Umožňuje uživateli nastavit velikostní nastavení. 

Pokud uživatel nastaví definovaný mód, uživatel bude dotázán zvolit 

nastavení velikosti pokaždé, když zapne stroj. 

Pokud je nastaven na výchozí roli, velikost role bude 

přednastavena pokaždé, když stroj bude zapnut. 

User Defined 

/Default Roll 
User 

Defined 

First Back to 

Origin 
Slouží k vrácení nože na původní místo; když je vybrán 

“Enable” nůž se nevrátí na původní místo, zatímco když je 

vybráno “Disable” umožňuje k navrácení na původní místo. 

Enable 

Disable 
Enable 

Auto Unrolled 

Length 
Pro nastavení odvíjecí délku média. 500-3000 mm 500 mm 

DHCP Ukazuje IP adresu pro TCP/IP configuraci  Disable 

IP adresa Ukazuje IP adresu Vašeho řezacího plotru   

MAC adresa Ukazuje adresu MACu Vaěeho řezacího plotru   

Rear Paper 
Sensor 

Pokud chcete zjistit, zda zadní senzor papíru je zakryt: 

Pokud je nastaveno na „enabled“, plotr bude detekovat, zda materiál 

zakryl zadní senzor papíru a to pod Roll and Edge módem. Pokud je 

„disabled“, senzor zadního papíru nebude detekovat materiál. 

Poznámka: senzor zadního papíru funguje pouze pod „Roll“ a 

„Edge“ módu. 

Enable, 

Disable 

Enable 
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 4. Činnosti/ Provoz 

4.1. Založení média 
4.1.1. Založení archu 
 

Krok 1 

Použijte páku přítlačných koleček umístěnou v horní pravé části řezacího plotru ke zvednutí nebo položení 

přítlakových koleček. Přitáhněte páku přítlakových koleček nahoru k jejich zvednutí. (Obrázek 4-1). 

 
 
 

Páka 
 
 
 
 
 
 
 
 
 

 
 

 Obrázek 4-1

 

Krok 2 

Vložte médium na pracovní desku a klouzavým pohybem ho podsuňte pod přítlačná kolečka buď z přední, 

nebo ze zadní části řezacího plotru. Barevné srovnávací pravítka na pracovní desce Vám pomůžou 

dokonale srovnat médium. 

 
 

 
 
 

Poznámka: 

Ujistěte se, že médium zakrývá 

senzory materiálu pracovní plochy, 

když médium zakládáte. Alespoň 

jeden ze dvou senzorů média by měl 

být zakryt (Obrázek 4-2). Jakmile 

jednou senzor načte médium, řezací 

plotr bude načítat tuto velikost 

a šířku média automaticky. 

 

 
 
 
 
 
 
 
 
 
 
 

Senzory 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Obrázek 4-2 
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Krok 3 

Posuňte přítlačná kolečka na správní pozice. Ujistěte se, že přítlačná kolečka jsou nad vodícími válci. 

Pomůžou Vám bílé značky umístěné nad válci na hlavním nosníku. (Obrázek 4-3). 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Krok 4 

Přítlačná kolečka opět položte stlačením páky přítlačných koleček směrem dozadu. 
 

Krok 5 

Zapněte plotr, vozík nástroje automaticky změří rozměry média. A řezací plotr může začít pracovat. 
 

 

Poznámka: 

1. Vždy pohybujte pouze se zvednutými přítlačnými kolečky. 

2. Přesunujte přítlačná kolečka uchopením za jejich zadní část. 

3. Nedržte přítlačná kolečka za jejich gumovou část během jejich přesunu. (Obrázek 4-4). 
 

 
 
 
 
 

(X) 
 

Špatně 
 
 
 
 
 
 
 

Obrázek 4-4 

Bílé značky 

Obrázek 4-3 
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Poznámka: 

Prosím, vytáhněte spodek všech přítlačných válečků (Obrázek 4-5), předtím než páku zatlačíte dozadu 

pro zajištění přesné šířky média. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Vytáhněte dolejšek k uvolněnímu sevření. 

 

 
 

Správně 
 
 

Obrázek 4-5 

 

4.1.2. Založení média 

Krok 1 

Nasuňte vodící svěrky na oba držáky role. (Obrázek 4-6). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Obrázek 4-6 

Vodící svěrky držáku role 
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Krok 2 

-- Možnost A (Doporučena) 

Vložte oba držáky role do uložení držáků role, pak položte roli média přímo mezi tyto dva držáky. 

(Obrázky 4-7). 

Poté vložte roli fólie na držáky role. Nastavte pozici role a ujistěte se, že oba držáky role jsou 

schopny bez problému běžet. (obrázek 4-8). 

 

 

 

 

 

 

 

 

 

Obrázek 4-7       Obrázek 4-8 

 
 
 
 

 

-- Možnost B 

Vložte kotouče na oba konce role a utahujte pomocí šroubů, dokud není role pevně sevřena. 

(Obrázek 4-9). 

 

 

 

 

Obrázek 4-9 
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Krok 3 

Vložte médium na pracovní plochu. Prosím, nahlédněte do kapitoly “4.1.1 Založení archu”. Napněte 

médium na pracovní ploše a pevně držte přední okraj role. (Obrázek 4-10). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Obrázek 4-10 Obrázek 4-11 

 
 

Krok 4 

Potom pootočte rolí zpět pro vytvoření souvislého 

napětí po celé ploše média. (Obrázek 4-11). 

 

Krok 5 

Umístěte přítlačná kolečka na značky – nad vodící válce. 

 

Poznámka: 

Ujistěte se, že napětí média je 

rovnoměrně rozprostřeno 

z leva doprava. Jestliže 

médium není správně napnuté, 

mohlo by to způsobit 

problémy s odvíjením.

Krok 6 

Přítlačná kolečka položte stlačením páky přítlačných koleček směrem dolů. 
 

Krok 7 

Upevněte vodící kotouče role na držácích role, aby se médium bezpečně odvíjelo. 

 

Krok 8 

Zapněte plotr a vyberte Roll, Edge nebo Single mód pro nastavení nebo nastavte Default Roll v nastavení 

velikosti (Sizing Setting) a nastavení typu role bude nastaven, když je plotr zapnutý. 

Řezací plotr může začít pracovat. 

 

 

 

Krok 9 

K vyjmutí média použijte opačný postup. 
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4.2. Nastavení vedení média 
 

Pro dosažení co nejlepšího vedení média pro dlouhý řez, doporučujeme několik zásadních postupů, 

které jsou popsány níže. 

Jestliže je délka média menší než 4 metrů, nechte okraj široký 0,5 mm – 2 5mm, na levém i pravém okraji média. 

(Obrázek 4-12). 
 
 
 
 
 
 
 
 

0.5 mm – 25 mm 0.5 mm – 25 mm 
 

 
 

přítlačné kolečko přítlačné kolečko 
 

 

Obrázek 4-12 

Jestliže je délka média větší než 4 metry, nechte okraj široký minimálně 25 mm, na levém i pravém okraji 

média. (Obrázek 4-13). 
 
 
 
 
 
 
 

 
> nebo = 25 mm > nebo = 25 mm 

 

Obrázek 4-13 
 
 
 
 

 
Pro více detailu se podívejte na odstavec “4.5 Jak vyříznout dlouhý řez”. 

 

Poznámka: Uživatelé řezacího plotru Jaguar V-61LXE mohou používat pro vedení média základní držák 

role. Lze upravit polohu držáků podle šířky materiálů. 
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4.3. Nastavení řezacího přítlaku a ofset 
 

Před posláním Vaší práce do plotru, můžete provést CUT TEST k zajištění správného výstupu. Cut test byste 

měli opakovat, dokud si nebudete jisti, že výchozí kvalita je na dobré úrovni. 

 

Po změření média zmáčkněte tlačítko [CUT TEST], k vybrání čtverečního testu zmáčkněte [ENTER]. 

 

Tovární nastavení přítlaku a offsetu jsou: 80gf a 0.275 mm. Pro posun nože na místo, které chcete, použijte 

šipky [ARROW KEY]. Poté stiskněte [ENTER] pro vykonání řezacího testu (cut test). 

 

Poznámka: Zároveň, nový počátek je nastaven jako pozice testu řezání. 
 

Po dokončení testu Vám výsledek vyjede. Odlepte médium na místě, které jste řezali. Pokud Vám jde 

jednoduše odlepit kousek, který jste řezali, tak to je správně. Pokud Vám nejde vyseparovat nebo jste řezali 

do bezpečnostní drážky, tak zmáčkněte [FORCE] klávesu a nastavte jiný přítlak. (Obrázek 4-14) 

 
 

 
 

 
 

Pokud se vzorek zdá být BB nebo CC, stiskněte 

tlačítko offsetu a nastavte novou hodnotu offsetu 

a to do té doby než bude vzorek tvaru AA. 

 

 

 

 

 

 

 

 

 

Obrázek 4-14 
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4.4. Jak vyříznout 3 mm písma 
 

Pro dobrou kvalitu výstupu doporučujeme úzké médium, každopádně použití širšího média je také možné. 

1. Zmenšit vzdálenost přítlakových koleček. 

2. Ujistěte se, že vložené médium je drženo rovně se stejným napětím přes celou plochu. 

3. Změnit nastavení: 

• Tool force (přítlak): na 55 (záleží na materiálu a vysunutí nože) 

• Cutting speed (rychlost řezání): 45-50 cm/s 

• Smooth cut (vyhlazování): na „Disable“ 

• Quality (kvalita): „Small Letter“ 

 

4.5. Jak vyříznout dlouhý řez 
 

Pokud chcete řezat dlouhý řez se širokou nebo těžkou rolí, tak je dobré nastavit funkci “AUTO UNROLL 

MEDIA“. Následující parametry mají pomoc uživateli pro nejlepší kvalitu řezu. Skutečná kvalita se může 

lišit při použití různých druhů materiálů. 

 

1. Pokud je délka grafiky mezi 3-5 metru, je lepší nastavit rychlost méně než 

72 cm/sec a řezací kvalitu nastavit na normální. 

2. Pokud je délka média delší než 5 metrů anebo typ materiálu, který je těžký 

řezat, je lepší zadat nižší rychlost řezání. 

3. Po založení média zvedněte přítlačná kolečka, vyhlaďte médium a pevně 

podržte přední okraj. (Obrázek 4-15). 

 
 
 
 
 
 
 
 
 
 

 
 

Obrázek 4-15 
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Poté otáčejte válečkem dolů, tak aby médium bylo napnuté na všech stranách stejně. (Obrázek 4-16) 
 

 
Ujistěte se, že médium je napnuté 

rovnoměrně z leva doprava. Pokud 

médium není napnuté rovnoměrně, 

může to způsobit problémy. 

 
 
 
 
 

 

Obrázek 4-16 
 
 
 

4. Dejte přítlačná kolečka dolů. 

5. Zajistěte vodící pouzdra držáku role. 

6. Délka výstupku nože by měla být delší než tloušťka vinylu. (Prosím, zkontrolujte “Specifikace 

nože: O nástroji” v dodatku). 
 

4.6. Po dokončení řezání grafiky 
 

Po dokončení řezání, zvedněte přítlačná kolečka a vyjměte materiál. Můžete také odříznout hotový materiál 

pomocí bezpečnostního nože (standardní příslušenství) podél průvodce nože. (Obrázek 4-17). 
 

 
 
 

 
 

Obrázek 4-17 
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4.7. Jaguar V nastavení tiskového ovladače 
 

4.7.1. Jaguar V nastavení tiskového ovladače -> volby 

 
 

Nastavení (Setting): Řezací plotr můžete seřídit v sekci nastavení. 

 

Kvalita (Quality): 

[Slower speeds / higher quality - Faster speeds / lower quality] 

Funkce nastavení řezací kvality Vám umožňuje seřídit a vyrovnat vektorový mód kvality a nastavení rychlosti 

podle Vaší specifické práce. Draft Mode nabízí největší výkonnostní rychlost, na úkor kvality Zatímco Small 

letter (malá písmena) mód nabízí největší kvalitu, na úkor rychlosti výkonu. Mějte na paměti, že rychlost je na 

úkor kvality a opačně. 

 

Použití nastavení plotru (Use Plotter Setting): 

Parametry nastavení budou nastaveny podle nastavení z kontrolního panelu. 
 
Zpátky domu (Back to Home): 

Když tuto možnost zvolíte, hlava plotru se vrátí na originální místo. 
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Řezání po sekcí (Section Cutting): 

Při řezáním dlouhé grafiky lze využít možnost řezání po sekcí, díky tomu je řezání stabilnější a dosahuje vynikající 

kvality řezu. Lze nastavit řez podle registračních značek nebo zadat hodnotu ručně. Když řezací plotr dokončí 

řezání v sekci 1, bude pokračovat v řezání v sekci 2. Obrázek je uveden níže: 

 
 

Funkce souboru (File Function): 
 
Výběr funkce souboru umožňuje hospodařit s různými parametry. Tento výběr je užitečný, když provádíte 

opakovanou práci na různých objektech, umožňuje uložit nejpoužívanější parametry a načíst je v budoucnu. 

 
• Custom Media: Tento výběr obsahuje list souborů, které jste nedávno vytvořili a používali. Můžete 

uložit více jak 50 souborů. 

• Default: Tato sekce obsahuje referenční nastavení, které jsou použitelné s ověřenými materiály pro 

dosažení nejlepšího výsledku řezu. Hodnoty nastavení mohou být potřeba změnit, a to z důvodů různých 

materiálů. 

• SAVE: Tato funkce uloží současné nastavení parametry tisku do specifického souboru ve Vašem počítači. 

(Uložené nastavení parametrů bude označeno příponou Jaguar V série). 

• LOAD: Tato funkce Vám umožňuje načíst předtím uložené parametry. 

• ORIGINAL: Tato funkce načte původní (tovární) nastavení parametrů 

• SAVE TO DEFAULT: Tato funkce Vám umožňuje uložit stávající parametry, které se budou 

automaticky nastavovat po zapnutí plotru. 

• DELETE: Tato funkce vymaže soubor, který jste vybral ze sekce „Custom Media“, přičemž v nastavení 

sekce „Default“ nelze vymazat. Prosím, zaznamenejte si, že tato funkce odstraní soubory pouze ze sekce 

„Custom Media“, neodstraní je celkově. Pokud si přejete soubor vymazat úplně z hard disku, budete ho muset 

manuálně vymazat z operačního systému. 
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• DIE CUT: Funkce Die Cut musí být zapnuta zároveň s funkcí Kiss Cut, aby se vyhnulo zmačkání materiálu. 

Die Cut umožní proříznout podložku materiálu, zatímco Kiss Cut řeze pouze materiál (ne spodní část). Díky 

tomu budou pouze malé kousky podkladu přichycené k materiálu (obrázek 4-18 a 4-19) 

 
Obrázek 4-18 

 

 

 

Obrázek 4-19 

 

Pro nastavení Die Cut funkce, přejděte do záložky Option->Die Cut a vyplňte hodnoty délka „Length“ a  

přítlak „Force“, jak pro Die Cut, tak pro Kiss Cut -> poté potvrďte pomocí tlačítka OK (obrázek 4-20). 
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Obrázek 4-20 

 

 

Když je práce hotová a vy vypnete funkce Die Cut, budete moc nastavit rychlost, offset a přítlak kreslícího 

nástroje v horní sekci následující normálních provozních postupů.  

 

Poznámka: 

1. Rozšíření nože musí být nastaveno na řezání horní i dolní části materiálu, a to na samém začátku. 

2. Jednou jak je funkce Die Cutu nastavena, bude provedena na celém objektu. 

 

Poznámka:  

Nastavení délky pro řezací linii Die Cutu je 

možné zadat v rozmezí 0-2000 mm zatímco 

pro Kiss Cut je rozmezí 0-100 mm. 
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4.7.2. Jaguar V nastavení ovladače tisku -> Paper Page 

 
 

Velikost papíru (Paper Page) [Automaticky nastaveno: Y = šířka stroje; X délka bude automaticky nastavena 

na dvojnásobek šířky Y] 

 

Velikost papíru reprezentuje Vaši absolutní pracovní plochu. Hodnota X reprezentuje délku a hodnota 

Y reprezentuje šířku. Velikost papíru by měla být nastavena na to samé jako je Váš obrázek, tak získáte lepší 

kvalitu řezání. 

 

Jednotka (Paper Page) [Automaticky nastaveno: Metrický (mm)] 

 

Tady můžete nastavit jednotky, které byste rádi použili. Můžete si vybrat mezi metrickými a imperiálními jednotky.  
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4.7.3. Jaguar V nastavení ovladače tisku -> Paper Feeder Page 

  
 

Nastavení Paper Feeder funguje, když je v souboru řezání použito nastavení 2bodové polohovací registrační 

značky. Viz část A4 Přidat dvoubodové registrační značky nebo A 5 Přidat dvoubodové registrační značky. 

- Počet opakování: definování počtu požadovaných kopií v jedné úloze řezání. 

- P3 (X, Y) / P4 (X,Y): pro nastavení hodnoty posunu X a Y (vodorovná čára je definována jako Y a svislá jako 

X, když je obrácena k řezacímu plotru). 

 

Pokud je třeba změnit skutečnou řeznou čáru a vytištěnou čáru směrem ke značce P1, pak stačí přidat zápornou 

hodnotu posunu. Pokud je směr opačný než značka P1, pak zadejte kladné hodnoty odsazení. Tato metoda platí 

pro osy X i Y. 
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4.8 Orientační parametry pro nastavení různých materiálů 
Následující referenční parametry jsou použity na GCC ověřených materiálech zobrazených v tabulce. 

 

Materiál Samolepky na zeď Magnety 
Personalizované 

nálepky 
Okenní dekorace 

Nůž červený zelený červený červený 

Délka špičky nože 

(mm) 
0.3 0.8 0.28 0.25 

Přítlak (g) 95 580 105 95 

Rychlost (cm/sec) 72 3 72 65 

Offset (mm) 0.275 0.5 0.275 0.275 

Doporučený model 

RX, Jaguar, Puma, 

EX-P, Bengal, 

EXII, AR-2 

RX, Jaguar 

RX, Jaguar, Puma, 

EX-P, Bengal, 

EXII, AR-24 

RX, Jaguar, Puma, 

EX-P, Bengal, 

EXII, AR-24 

Materiál Autofólie Reflexní fólie Karton Flock 

Nůž červený zelený zelený zelený 

Délka špičky nože 

(mm) 
0.27 0.5 0.3 0.3 

Přítlak (g) 85 380 165 135 

Rychlost (cm/sec) 60 3 30 30 

Offset (mm) 0.275 0.5 0.5 0.5 

Doporučený model 

RX, Jaguar, Puma, 

EX-P, Bengal, 

EXII, AR-24 

RX, Jaguar, Puma, 

EX-P, Bengal 

RX, Jaguar, Puma, 

EX-P, Bengal, 

EXII, AR-24 

RX, Jaguar, Puma, 

EX, AR 

Materiál Okenní tónování 
Ochranné 

tónování 
Rhinestone Sandblast 

Nůž Červený/žlutý zelený zelený Modrý 

Délka špičky nože 

(mm) 
0.09 0.3 0.8 0.27 

Přítlak (g) 70 320 190 85 

Rychlost (cm/sec) 72 3 15 60 

Offset (mm) 0.25 0.5 0.5 0.25 

Doporučený model 
RX, Jaguar, Puma, 

EX, AR 

RX, Jaguar, Puma, 

EX 
RX, Jaguar, Puma 

RX, Jaguar, Puma, 

EX, AR 
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5. Optický poziční systém (AAS II) 
 

Tato kapitola je pouze úvod do AAS II; pro intrukce krok po kroku nalistujte následující kapitoly: 08_A-3 

CorelDraw Plug-In, 08_A-4 Illustrator Plug-In, 08_A-5 GreatCut Plug-In. 

 

5.1. Úvod 
 

Řezací plotry Jaguar V LX obsahují standardní Optický poziční systém (AAS II), který zaručuje přesné 

řezání kontur tím, že zachytí registrační značky vytištěné kolem grafiky. 
  
 

Poznámka 

• Vyhněte se jakémukoliv druhu světla, které by svítilo horizontálně na AAS systém.  
 
 
 
 
 
 
 
 
 
 
 
 
 

- ŠPATNĚ - PŘIJATELNÉ 
 

 
 
 

• NEoddělujte kryt AAS modulu během operace. 
 

 
 

- ZAKÁZANO 
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5.2. AAS Kalibrace systému 
 
 

AAS systém má jednu kalibrační proceduru, aby zaručila maximální přesnost AAS operaci. Pro 

pracování s AAS se nejdříve budete muset naučit o metodě založení média. (Zmiňování 4.1 založení 

média.) 
 

 

5.2.1. Kalibrace média 

Kalibrace senzorů zajišťuje jejich schopnost rozpoznat poziční značky. Výchozí tovární nastavení 

funguje na většinu fólií. Nicméně, u některých materiálů se může stát, že detekce pozičních značek 

nebude fungovat správně. Kalibrace je nutná při práci s různými materiály, u kterých je různá 

citlivost senzorů.  

 
• Kdy použít 

Doporučujeme bílé médium pro lepší výsledek řezu. Není nutné provádět Media Calibration 

pokaždé při použití různých barevných materiálů nebo různých druhů materiálů, ledaže by poziční 

značky nebylo možné na daném materiálu detekovat. 
 

 

5.2.2. AAS Kalibrace 

První poziční značka je navržena tak, aby byla odlišná od ostatních pro snazší identifikaci počátku 

AAS. Pro správní fungování AAS automatické detekce věnujte pozornost následujícím bodům: 

• Typ média 

• Poloha počátečního bodů 

• Poziční značky a jejich umístění podle vzoru 

• Umístění značek na médiu 

• Dostatečný prostor potřebný pro detekci pozičních značek 

Parametry pozičních značek: 

• Vytvořeno řezacím softwarem jako je SignPal nebo GCC CorelDRAW plug-in 

• Černá barva (řezací kvalita pozičních značek je zásadní; nesprávné, nevyrovnané barvy, 

rozmazaný nebo zamazaný výtisk vede k nepřesnému řezání), 

• Délka značky: 5 mm~50 mm, doporučeno 25 mm 

• Tloušťka značky: 1 mm~2 mm, doporučeno 1 mm 

• Okraje: 0 mm~50mm, doporučeno 5 mm 

Plotr špatně detekuje, když je: 

• Vozítko nástrojů není umístěno blízko u první značky před detekováním. 

• Tloušťka materiálu větší než 0.8 mm 

• Transparentní materiál je použit.
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• Ne jednobarevný podklad. Značky nemohou být detekovány, pokud jsou značky 

vytisknuty na barevné médium. 

• Zašpiněný nebo pomačkaný povrch média 
 

 

5.2.3. AAS II na Jaguar V 

Jsou tři typy AAS II vzorových značek: 4-Point Positioning, Segmental Positioning, and Multiple Copies. 

Poznamenejte si, že před tisknutí Vašich návrhů, musí být registrační značky graficky vytvořeny ve Vašem 

řezacím software jako je GreatCut, SignPal nebo GCC CorelDraw plug-in. Ručně vyrobené registrační 

značky nebo nákresy nebudou rozpoznány řezacími plotry GCC. Pro více detailů o registračních značkách 

a jejich nastavená v řezacím software, prosím navštivte. 

‘Příloha A-3 : CorelDraw Plug-In Instrukce”, ‘Příloha A-4 : Illustrator Instrukce’, 

‘Příloha A-5 : GreatCut Instrukce, Příloha A-6: SignPal 10.5 Instrukce 
 

 
1. 4 - bodové pozicování (4-Point Positioning) 

Toto je základní vzorová značka AAS II, která bude automaticky detekovat 4 registrační značky 

a obrysy řezacích obrázků dovnitř těchto značek. 

• Příkaz: Esc.D1;(XDist);(YDist): 

• Rozmístění: 4 L-tvar značky ve 4 rozích kolem obrázku 
 

 
 

2. Segmentové pozicování (Segmental Positioning) 

Krom 4 originálních bodů, uprostřed jsou přidány registrační značky na obou dvou osách pro větší 

přesnost řezu a to zejména u řezání větších objektů. 

• Příkaz: Esc.D2;(XDist);(YDist);(XStep);(YStep): 

• Rozmístění: 

Prostřední vzdálenost na X: 200~600 mm, dáno 300 mm 

Prostřední vzdálenost na Y: 200-600 mm, dáno 300 mm 
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• Řezání dlouhého designu (řezání po sekcí) 

Jaguar V vykonává řezání po sekcí pro nejvyšší možnou kvalitu řezání 

o Objekt bude následovat sekci pattern na základě nastavení Segmentového pozicování. 

o Postup řezání: Section 1->Section 2-> Section 3-> Section 4 

 
 

3. Hromadné kopie 

Tato funkce se používá pro duplikaci objektů, aby se snížilo množství snímků najednou. AAS II sensor 

bude automaticky skenovat registrační značky pro každý jednotlivý objekt, aby zajistil přesnost obrysu 

řezu. 

• Příkaz: Esc.D3;(XCopies);(YCopies);(Space): 

• Rozmístění: 

Stav 1 (Automaticky nastavena) Stav 2 
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5.2.4. Automatické rozlišení směru výstupu 
Pro pohodlí uživatele, Jaguar V automaticky detekuje směr podávání materiálu při provádění řezu kontur. 

Obrázek 5-1 zobrazuje detekci posloupnosti registračních značek, když je materiál podáván standardním 

způsobem (1->2->3->4), zatímco Obrázek 5-2 zobrazuje, jak Jaguar V detekuje registrační značky, pokud 

je materiál podívám obráceně (3->4->1->2). Jaguar V je schopný detekovat registrační značky, a to bez 

ohledu na to, jak uživatel podává materiál. 

 

Postup detekce směru: (viz obrázek 5-2) 

a. Detekce pozice třetí registrační značky 

b. Postup ke čtvrté registrační značce pro detekci směru. 

c. Informace jsou poslány do driveru a přepočítány před výstup. 

d. Detekce objektů a proces výstupu je realizován (postup registračních značek (3->4->1->2). 

 
Obrázek 5-1   Obrázek 5-2 

 

5.3. Seřízení AASII v osách X-Y 
 

Před započetím práce s AAS ořezem se doporučuje provést test tiskárny. Slouží ke zjištění kvality tisku potřebné 

pro přesné obřezávání. Přejděte na stánku https://www.gccworld.com/download.php?act=view&id=20 a stáhněte 

soubory pro testování. 

 

Existují dva testovací soubory pro AASII: 

1. AAS II_X_Y_Offset_Caberation_A4 .eps (A4 formát) 

2. AAS II_X_Y_Offset_Caberation_600_600 .eps (Automatické nastavení, je doporučeno pro testování) 

▪ Vytiskněte testovací grafiku na tiskárně (Prosím, použijte vysokou přesnost tiskárny). 

▪ Nahrajte vytištěnou grafiku do Jaguar V plotru a pošlete do plotru data pro ořez. 

▪ Pokud jsou zde nějaké odchylky, je možné seřídit AAS offset podle následujících kroků:  

o Změřte offsetové hodnoty mezi vytisknutou a vyříznutou linkou. 

o Zadejte AAS Offset podle funkcí MISC, pro hodnoty, které jsou právě měřeny a stiskněte Enter. 
o Proveďte znovu fázi testu s detekcí a ořezem. 

o AAS II offsetové X a Y hodnoty jsou definovány následovně: \orizontální linka – X, vertikální linka- Y 

(při pohledu ze předu) 

o Pokud aktuální řezací linie a vytištěná řezací linie je potřeba změnit ve směru původních značek, 

potom jednoduše přidejte negativní hodnoty offsetu. Pokud směr je z protějších originálních značek, 

potom přidejte positive hodnoty offsetu. Tato metoda platí na obě dvě osy X a Y. 
 

https://www.gccworld.com/download.php?act=view&id=20
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Například: 

Pokud hodnota nastavení je X: 0.50 mm Y 0.50 mm a rozměry jsou: 

X1:-0.25 mm, Y 1:+0.25 mm. (V následujícím obrázku modrá čára představuje hodnotu Y a červená 

představuje špičku hodnoty X.) 

Potřebuje seřídit AASII offset X nový : (X + X1) Y nový : (Y + Y1) což znamená X 

nový: 0.25 mm, Y nový: 0.75, poté uložte nové nastavení hodnot. 
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Poznámka:

• Před seřizování AAS II nastavení, prosím zkontrolujte šířku a délku. 

• Také zkontrolujte nastavení offsetu nože. 

• Pokud máte nějaké nejasnosti, kontaktujte Vašeho dodavatele pro asistenci. 
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5.4. Rozsah ofsetu registračních značek 
 

Prosím, načtěte správně fólii pro úspěšné detekování registračních značek. Odchylka přesahující rozsah níže 

povede k selhání detekce. 

 
 

5.5. Řezání kontury 
 

Pro přesné řezání kontury s AAS funkcí, postupujte prosím podle následujících kroků: 
 

Krok 1: Vytvoření grafiky 

• Vytvořte grafiku, kterou chcete vytisknout a řezejte ze softwawru. 
 

 
 

• Vytvořte obrysy kolem Vaší grafiky. 
 

 
 
 
 
 

TIP 1: Nechte nějaké místo mezi grafikou a obrysovou čárou. 

TIP 2: Vytvořte obrys v samostatné vrstvě a přiřaďte mu jinou barvu. 
 

• Vložte tiskové značky kolem grafiky. 
 

 
Poznámka: 

Funkce hromadné kopie jsou také možné. Automaticky to zkopíruje grafiku a poziční značky. 
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Krok 2: Umístění tiskových značek. 

• AAS rozvržení instrukce: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

* Auto-detekovací funkce na 1. značce kryje šedou oblast. 

• Doporučeno 30mm okraje na levé a pravé straně listu média. 

• Doporučeno 20~30mm okraje na horním části média a alespoň 50mm okraje na spodku 

listu média, aby se předešlo jakékoliv chybě. 
 
 

Krok 3: Tisknutí grafiky 

• Vytiskněte grafiku a značky. 
 

(změna velikosti = 100 %).  

 
• Když tisknete na roli média, ujistěte se, že orientace je následující: 
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Krok 4: Vložte výtisky na řezací stroj 

• Původní značky jsou odlišné od zbylých značek. Prosím, ujistěte se, že médium je umístěno ve 

správném směru. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Krok 5: Řezání kontury 

• Vyšlete příkaz ze softwaru, aby byla provedena řezací práce. 
 
 

5.6. Tipy pro AAS systém 
 

Abyste dostaly lepší výsledky při řezání s optickým pozičním systémem, můžete použít několik z níže 

popsaných tipů. Tyto body nejsou nutně nezbytné k řezání s optickou hlavou. 
 

o Doporučujeme používat plotr za stejného osvětlení, tzn. neumisťovat k oknu, kde může 

docházet ke změnám světelnosti v průběhu dne.  

o Před prací s optickým pozičním systémem nastavte maximální šíři média v driveru pro 

Jaguar V. 

▪ Krok 1: Najděte Jaguar V model v “Printer & Fax” složka Vašeho PC.  

▪ Krok 2: Otevřete okno s vlastnostmi a vyberte “Paper” záložku.  

▪ Krok 3: Změňte maximální velikost papíru na ose X na 1200 mm. 

o Nastavte rychlost řezání mezi 300~600 mm/sec. 

o Vyhněte se umístění koleček na místě, kde jsou ořezové značky. 

o Ujistěte se, že okraj média není ohnutý. 
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6. Údržba 
Tato kapitola popisuje základní údržbu (tj. čištění řezacího plotru), kterou řezací plotr vyžaduje. Kromě níže 

zmíněného, veškerá další údržba musí být provedena kvalifikovaným servisním technikem. 
 
 

6.1. Čištění řezacího plotru 

Abyste udrželi plotr v dobrém stavu a výborném výkonu, musíte stroj čistit řádně a pravidelně.  
 
 

 Opatřeni při čištění!   

▪ Odpojte plotr před čištění, vyhnete se tak úrazu el. proudem. 
 
 

▪ K čištění nepoužívejte rozpouštědla, tuhé (brusné) čističe nebo 

silné čisticí prostředky. Mohou zničit povrch řezacího plotru a 

jeho pohyblivé části. 

 

 

 

Doporučení metody: 

▪ Hladkou látkou šetrně otřete povrch plotru. Jestliže je to nutné, použijte vlhký hadřík nebo alkohol. 

Otřete vodou, abyste opláchly zbytky a lehce osušte látkou bez chlupů. 

 
▪ Setřete veškerý prach a špínu z kolejnic řezací hlavy. 

 
▪ Použijte vakuový čistič k odstranění nahromaděné špíny a zbytků fólie pod krytem přítlačných koleček. 

 
▪ Očistěte desku, senzory média a přítlačná kolečka vlhkým hadříkem nebo alkoholem a osušte jemným 

hadříkem bez chlupů  

 
▪ Odstraňte prach a špínu ze stojanu plotru.  
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6.2. Čištění vodícího válce 
 
1. Vypněte řezací plotr a odsuňte hlavu nože z místa, které chcete vyčistit. 

 
2. Zvedněte přítlačná kolečka a odsuňte je z vodícího válce na místech, které chcete čistit. 

 
3. Použijte štětec (nebo zubní kartáček) k odstranění prachu z povrchu. Při čištění točte válcem ručně, viz 

Obrázek 6-1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Obrázek 6-1 
 
 
 
 

6.3 Čištění přítlačných koleček 
 
 

1.  Pokud přítlačná kolečka potřebují důkladné čištění, použijte hladkou látku nebo tampón k vytření 

nahromaděného prachu z gumových částí přítlačných koleček. Aby se Vám přítlačná kolečka během 

čištění neotáčela, použijte prst k jejich přidržení. 

 

2.  Jestliže potřebujete odstranit zašlou nebo zažranou špínu a prach, použijte hladkou látku nebo tampón 

namočený v čistém alkoholu. 
 
 

Poznámka: Denní údržba Vašeho řezacího plotru je velmi důležitá. Čistěte 

mřížky válce a přítlačná kolečka pravidelně, pro lepší přesnost řezání a kvality 

výstupu. 
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7. Poradce při problémech 
Tato kapitola Vám pomůže vyřešit některé běžné problémy, na které můžete narazit. Ještě před proniknutím 

do detailů této kapitoly se prosím ujistěte, že Vaše aplikace je kompatibilní s tímto řezacím plotrem. 
 

  
 
 

Poznámka: Než svůj plotr předáte do servisu, ujistěte se 

prosím, že špatné fungování je způsobeno řezacím plotrem, 

ne výsledkem problému spojení Vašeho počítače nebo 

problémem ovládacího softwaru! 

 
 
 
 
 
 
 
 
 
 

Proč řezací plotr nepracuje? 
 
 
 
 
 
 
 

Řezací potíže: 
 
 

7.1. Problémy ne operační 
 

Následující položky zkontrolujte jako první: 

▪ Je napájecí šňůra pevně zasunuta? 

▪ Je šňůra správně zasunuta do napájecí zásuvky? 

▪ Svítí kontrolka napájení (power LED)? 
 

 
Řešení: 
 
Pokud je displej schopen zobrazovat zprávy, pak by řezací plotr měl být v normálním stavu (bez 

poruchy). Vypněte a následně opět zapněte Váš řezací plotr, abyste poznali, jestli problém přetrvává. 
 

 

Jestliže displej plotru nezobrazuje žádné zprávy, kontaktujte Vašeho dodavatele řezacího plotru. 
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7.2. Operační Problémy 
 

Některé mechanické problémy nebo poruchy během provozu způsobí některé problémy. Hlášení chyby 

(error) na displeji upozorňuje na problém jako první, následované doporučeným zásahem. Jestliže se 

problém stále vyskytuje i po doporučeném zásahu, potřebuje Váš plotr odborný servis.  
 

 
 

Error, Check Media 

Or Drum or X Motor 

Tato zpráva indikuje, že problém může být v X ose 

(X axis). Zkontrolujte, zda vodící válec pracuje 

správně a jestli médium je dobře založeno. Vyřešte 

problém a restartujte (vypněte a zapněte) řezací 

plotr kvůli rebootu vnitřního systému. 
 

 
 
 
 
 

 
Error, Check Media 

Or Y Motor 

Tato zpráva indikuje, že zde může být překážka 

obdobná předcházejícímu problému v ose Y (Y 

axis). Napravte problém a restartujte (vypněte a 

zapněte) řezací plotr kvůli rebootu vnitřního 

systému.  
 

 
 
 
 
 

 
Error, Check Carriage 

Sensor or VC Motor 

Tato zpráva upozorňuje na to, že zvedání 

a pokládání nože nefunguje správně. Restartujte 

(vypněte a zapněte) řezací plotr kvůli rebootu 

vnitřního systému. Jestliže problém pořád setrvává, 

vyhledejte servisního technika. 
 

 
 
 
 
 

 
Graph Was Clipped. 

Data In Buffer 

Tato zpráva upozorňuje, že délka řezané grafiky 

překračuje limit. Založte větší médium nebo 

zmenšete měřítko grafiky, pak zmáčkněte tlačítko 

umožňující pokračovat, jež se objeví na displeji. 
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7.3. Komunikační problémy řezacího plotru vs. Počítač 
 

Zprávy zobrazené níže představují problémy komunikace ve vztahu řezací plotr/počítač. 

 
 
 

 

Communication Error 

Setup: MISC. key 

Je správně připojen datový kabel 

mezi počítačem a řezacím 

plotrem? 

 
 

Ano Ne 
 
 

Byly správně nastaveny 

parametry komunikace? 
 

 

Ano Ne 

Kapitola 2 – Připojení 

Vašeho řezacího plotru 

 
 

Pokuste se o komunikaci mezi 

počítačem a řezacím plotrem. 

Jestliže pořád nefunguje, nechte 

plotr odborně seřídit. 

Zmiňuje “MISC” key v 

kapitole 3 – Popis parametrů 

v nastavení portu. 

 
 
 
 
 
 

Poznámka: 

Počítač také potřebuje nastavit parametry kompatibilní komunikace. 

 
 

 
 
 

 

HP-GL/2 Cmd. Error 

Pokud Váš řezací plotr nemůže rozpoznat 

příkazy jazyků HP-GL/2 nebo HP-GL, 

zkontrolujte prosím, zda příkazy HP-GL/2 nebo 

HP-GL používané k řezacímu plotru jsou 

správně používány.
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7.4. Softwarové Problémy 
 
Nejprve projděte následující: 

 

 

Je Váš software kompatibilní s Vaším počítačem a řezacím 

plotrem? 

Podporuje Váš software HP-GL a HP-GL/2 ovladače? 

(* zkontrolujte nastavení konfigurace Vašeho softwaru.) 
 
 

Ano Ne 
 
 

Splňuje připojení počítače a 

řezacího plotru požadavky Vašeho 

software? 

Většina známých řezacích softwarů na 

světě obsahuje ovladače pro naše 

řezací plotry. Jestliže ne, použijte 

software, který 

Ano 
 
 

Doporučuje  

Váš software 

použití jiného 

kabelu? 

Ne 
 
 

Odpovídá kapitola 

2 – Připojení 

Vašeho řezacího 

plotru 

má HP-GL/2 podporu emulace a 

můžete si vybrat z následujících třech 

ovladačů: 

▪ A3 size: HP7475A 

▪ A1 size: HP7580A 

▪ A0 size: HP Draf Pro Exl 
nebo HP Draf Master 

 
 
 

Ano 

 
Zkuste použít 

doporučený 
kabel. 

Ne 
 
 
Zajišťuje dodavatel 

softwaru vzorové 

soubory? 

 
 
 

Ano Ne 
 

Restartujte řezací 

plotr a zkuste 

soubor poslat 

znovu. 

Řiďte se zprávou o chybě na 

displeji nebo konzultujte se 

svým dodavatelem softwaru.
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7.5. Problémy s kvalitou řezu 
 
 
 

Poznámka: Denní údržba Vašeho plotu je velmi důležitá. Ujistěte se, že 

pravidelně budou vyčištěna mřížky válce a přítlačná kolečka 

pro lepší přesnost řezání a kvality výstupu. 
 
 
 
 

Je držák nože bezpečně utažen a nůž správně 

instalován? 

 
 

Ano Ne 
 
 

Je nůž ztupený/ 

hrot odštípnut? 

 
Ano Ne 

Popsáno v kapitole 2.4 

“ Instalace nože” 

 
 

Vyměňte 

nůž za 

nový. 

Je přítlak nože vhodně 

nastaven? 

(Přednastaveno 80 gf) 
 
 
 
Ano Ne 

 
 

Je offset nástroje 

nastaven správně? 

 
Ano Ne 

Vhodně nastavte přítlak nástroje, 

abyste získali optimální přítlak 

nože. V kapitole 4.3 “Úprava 

přítlaku a offsetu” 

 
 
 

Je nějaká špína nebo zbytky 

fólie na noži? 

 
Ano Ne 

Změňte offset k dosažení 

optimální hodnoty. 

 
 

Vyjměte nůž a 

očistěte ho. 

Prosím, kontaktujte technika Vašeho 

dodavatele. 
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8. Přílohy 
A-1: Jaguar V specifikace 
 

Model 
J5-61(LX)/J5-

61LXE 
J5-101(LX) J5-132(LX) J5-163(LX) J5-183LX 

Typ motoru Válcová 

Max. šířka řezání 610 mm 1016 mm 1320 mm 1627 mm 1830 mm 

Max. délka řezání 50 metru 

Max. šíře média 770 mm 1270 mm 1594 mm 1782 mm 1990 mm 

Min. šíře média 50 mm 300 mm 

Počet přítlačných kladek 3 4 6 

Akceptovaná tloušťka materiálu 0.8 mm (0.03in) 

Typ motoru DC Servo Control 

Přítlak 0~600 g 

Max. rychlost řezání 1530 mm/sec (60 ips) (při 45°) 

Zrychlení 4.2 G 

Offset 0~1.0 mm (se zvýšením 0.025 mm) 

Paměť 32 MB (J5) / 16 MB (J5LX) 

Rozhraní USB 2.0 (Full Speed), Serial (RS-232C) and Ethernet 

Typy příkazů HP-GL, HP-GL/2 

Mechanická přesnost 0.006 mm 

Software přesnost 0.025 mm 

Přesnost vzdálenosti ±0.254 mm nebo ±0.1 % pohybu, který je vyšší 

Opakovatelnost ±0.1 mm 

Vyhlazování křivek a oblouků Ano 

Nastavitelnost počátku Ano 

Řezací test způsobilosti Ano 

Tangenciální mód Ano 

Přeřezávání poč. bodu Ano 

Opakování Ano 

Kopírování Ano 

Kontrolní panel LCD (20 číslic x 2 řádky), 14 tlačítek, 1 Power LED, 1 zelená LED 

Průměr nože 2.5 mm 

Napájení AC 100-240V, 50~60 Hz (auto přepínání) 

Příkon  Max. 110 wattů 

Rozměry (VxDxŠ) mm           412 x 950 x 486 1096 x 1450 x 651 1111 x 1774 x 651 1127 x 1962 x 756 1127 x 2170 x 756  

(VxDxŠ) v 16.2 x 37.4 x 19.1 43.1 x 57 x 25.6 43.7 x 69.8 x 25.6 44,4 x 77,2 x 29,8 44.4 x 85.4 x 29.8  

Váha 8 kg 41.5 kg 50 kg 69 kg 88 kg  

Stojan Volitelně Standardní 

Optický poziční systém 

(AAS II) 
Jaguar V LX modely s kompletním ASS II pro řezání kontur. 

Koš na materiál Volitelně 

Provozní 

prostředí 

Teplota 15 °C~30 °C 

Vlhkost 25 % ~ 75 % 
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• Kompatibilní s Windows 7 a vyšší verze a MAC OS X 10.6 a vyšší verze. 

• Specifikace a datový list se mohou u různých použitých materiálů lišit. Abyste dosáhli nejlepší kvality 

výstupu, udržujte stroj pravidelně a řádně. 

• GCC si vyhrazuje právo na změny ve specifikacích, a to kdykoliv bez předchozího upozornění. 

• GCC certifikovaný materiál ve vedení média je Avery MPI 3000. 

• Výše uvedené specifické hodnoty jsou platné pouze při použití materiálů od GCC. 
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Specifikace Jaguar V LX – R: speciálně pro reflexní materiál. 

Model J5-61LX - R J5-101LX - R J5-132LX - R J5-183LX - R 

Typ motoru Válcový 

Max. šířka řezání 610mm (24in) 1016mm (40in) 1320mm (52in) 1830mm(72in) 

Max. délka řezání 50m (164ft) 

Max. šíře média 770mm (30.3in) 1270mm(50in) 1594mm(62.7in) 1990mm(78.3 in) 

Min. šíře média 50mm (1.97in) 300mm (11.8in) 

Počet přítlačných kladek 3 4 6 

Akceptovaná tloušťka materiálu 0.8 mm (0.03in) 

Typ motoru DC Servo Control 

Přítlak 0~600 g 

Max. rychlost řezání 1530 mm/sec (60 ips) (při 45°) 

Zrychlení 4.2 G 

Offset 0~1.0 mm (se zvýšením 0.025mm) 

Paměť 32 MB (J5) / 16 MB (J5LX) 

Rozhraní USB 2.0 (Full Speed), Serial (RS-232C) and Ethernet 

Typy příkazů HP-GL, HP-GL/2 

Mechanická přesnost 0.006 mm 

Software přesnost 0.025 mm 

Přesnost vzdálenosti ±0.254 mm nebo ±0.1% pohybu, který je vyšší 

Opakovatelnost ±0.1mm 

Vyhlazování křivek a oblouků Yes 

Nastavitelnost počátku Yes 

Řezací test způsobilosti Yes 

Tangenciální mód Yes 

Přeřezávání poč. bodu Yes 

Opakování Yes 

Kopírování Yes 

Kontrolní panel LCD (20 číslic x 2 řádky), 14 tlačítek, 1 Power LED, 1 zelená LED 

Průměr nože 2 mm 

Napájení AC 100-240V, 50~60 Hz (auto přepínání) 

Příkon  Max. 110 wattů 

Rozměry (VxDxŠ) mm           412 * 950 * 486 1096 * 1450 * 651 1111 * 1774 * 651 1127 * 2170 * 756  

(VxDxŠ) v 16.2 * 37.4 * 19.1 43.1 * 57 * 25.6 43.7 * 69.8 * 25.6 44.4 * 85.4 * 29.8  

Váha 18 kg 41.5 kg 50 kg 63 kg  

Stojan Volitelně Standardní 

Optický poziční systém 

(AAS II) 
Jaguar V LX models with Completely Automatic Contour Cutting System for print to cut solution 

Koš na materiál Volitelně 

Provozní 

prostředí 

Teplota 15 C~30 C / 60°F~86°F 

Vlhkost 25% ~ 75% 

 

• Kompatibilní s Windows 7 a vyšší verze a MAC OS X 10.6 a vyšší verze. 

• Specifikace a datový list se mohou u různých použitých materiálů lišit. Abyste dosáhli nejlepší kvality výstupu, udržujte stroj pravidelně a řádně. 

• GCC si vyhrazuje právo na změny ve specifikacích, a to kdykoliv bez předchozího upozornění. 

• GCC certifikovaný materiál ve vedení média je Avery MPI 3000. 

• Výše uvedené specifické hodnoty jsou platné pouze při použití materiálů od GCC. 
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• Specifikace Jaguar V LX – W: Speciálně pro okenní grafiku 

Model J5-61LX - W J5-101LX - W J5-132LX - W J5-183LX - W 

Typ motoru Válcový 

Max. šířka řezání 610mm (24in) 1016mm (40in) 1320mm (52in) 1830mm(72in) 

Max. délka řezání 50m (164ft) 

Max. šíře média 770mm (30.3in) 1270mm(50in) 1594mm(62.7in) 1990mm(78.3 in) 

Min. šíře média 50mm (1.97in) 300mm (11.8in) 

Počet přítlačných kladek 3 4 6 

Akceptovaná tloušťka materiálu 
0.8 mm (0.03in) 

Typ motoru DC Servo Control 

Přítlak 0~600 g 

Max. rychlost řezání 1530 mm/sec (60 ips) (při 45°) 

Zrychlení 4.2 G 

Offset 0~1.0 mm (se zvýšením 0.025mm) 

Paměť 32 MB (J5) / 16 MB (J5LX) 

Rozhraní USB 2.0 (Full Speed), Serial (RS-232C) and Ethernet 

Typy příkazů HP-GL, HP-GL/2 

Mechanická přesnost 0.006 mm 

Software přesnost 0.025 mm 

Přesnost vzdálenosti ±0.254 mm nebo ±0.1% pohybu, který je vyšší 

Opakovatelnost ±0.1mm 

Vyhlazování křivek a oblouků Yes 

Nastavitelnost počátku Yes 

Řezací test způsobilosti Yes 

Tangenciální mód Yes 

Přeřezávání poč. bodu Yes 

Opakování Yes 

Kopírování Yes 

Kontrolní panel LCD (20 číslic x 2 řádky), 14 tlačítek, 1 Power LED, 1 zelená LED 

Průměr nože 2 mm 

Napájení AC 100-240V, 50~60 Hz (auto přepínání) 

Příkon  Max. 110 wattů 

Rozměry (VxDxŠ) mm           412 * 950 * 486 1096 * 1450 * 651 1111 * 1774 * 651 1127 * 2170 * 756  

(VxDxŠ) v 16.2 * 37.4 * 19.1 43.1 * 57 * 25.6 43.7 * 69.8 * 25.6 44.4 * 85.4 * 29.8  

Váha 18 kg 41.5 kg 50 kg 63 kg  

Stojan Volitelně Standardní 

Optický poziční systém 

(AAS II) 
Jaguar V LX models with Completely Automatic Contour Cutting System for print to cut solution 

Koš na materiál Volitelně 

Provozní 

prostředí 

Teplota 15 C~30 C / 60°F~86°F 

Vlhkost 25% ~ 75% 

• Kompatibilní s Windows 7 a vyšší verze a MAC OS X 10.6 a vyšší verze. 

• Specifikace a datový list se mohou u různých použitých materiálů lišit. Abyste dosáhli nejlepší kvality výstupu, udržujte stroj pravidelně a řádně. 

• GCC si vyhrazuje právo na změny ve specifikacích, a to kdykoliv bez předchozího upozornění. 

• GCC certifikovaný materiál ve vedení média je Avery MPI 3000. 

• Výše uvedené specifické hodnoty jsou platné pouze při použití materiálů od GCC. 
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A-2: Specifikace řezacích nožů 
 

290088090G 

Pro řezání silných fluorescentních a reflexních fólií. Také pro řezání detailů do 

standardní fólie. 

Úhel břitu 45° s červenou čepičkou (5 kusů), 0.25 mm ofset a 2,5 mm 

průměr nože. 

 

290088080G 

Pro řezání reflexních fólií, papíru, pískovacích a šablonových fólií. 

Úhel břitu 60° s zelenou čepičkou, 0.50 mm ofset nože a 2,5 mm 

průměr nože. 

 

265017550G 

Pro řezání slabých pískovacích a šablonových fólií do válcových plotrů. 

Úhel břitu 60° s modrou čepičkou, 0.25 mm ofset nože a 2,5 mm 

průměr nože. 

 

265017560G 

Pro řezání malého textu a jemných detailů. Ostří nože s nejmenším offsetem. 

Ofset nože 0.175 mm s černou čepičkou a 2,5 mm průměr nože. 

 

265017530G 

 

Pro tenké a delikátní fólie, jako je okenní tónování. 

 

Úhel břitu nože je 25 ° se žlutou čepičkou, 0,25 mm offset a 2,5 mm 

průměr nože. 
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O nástroji 

 
Obecně se mluví o noži, který řeže fólie, o peru, které kreslí a o LED zaměřovači (volitelně) používanému 

k určení referenčního bodu. 

OFFSET je vzdálenost od hrotu nože k ose, kolem které se nůž otáčí. 
 
 
 
 
 
 

Nůž 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hrot nože 

Osa nože 

 
 

Offset 
 
 

Délka vysunutí hrotu nože 
 
 
 
 
 
 
 

Vysunutí hrotu 

Tloušťka fólie (t1) 

 
 

Tloušťka podkladní 

vrstvy (t 2) 
 
 
 
 
 

Vysunutí nože = t1 + t 2/ 2 (do poloviny podkladového materiálu), ale podle vlastního uvážení můžete 

nůž vysunout 0.3mm ~ 0.5mm za hranici špičky držáku nože. 
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A-3: CorelDRAW Plug-In 
 

AASII VBA Installer je vhodný pro CorelDRAW Version X3 - X8 
 
 

Instalace 

Prosím, jděte na Krok 8 v Kapitole 2.8.1.2. Instalace Driveru pro instalaci AAS II plug-in pro 

CorelDRAW. 

 

Spuštění CorelDRAW AAS Plug-in 

 

Krok 1: Zapněte CorelDRAW pro úpravu Vaší grafiky a vyberte najednou všechny obrázky, které budete 

chtít vyřezat. 

 

Krok 2: Vyberte „Tools->Macros->Run Macro.“ Poté vyberte Global Macros(GCCAASII_Draw13.gms) 

pod “Macros in” a zmáčkněte “Run”. 
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Krok 3: Kl ikněte  na “Apply” a vyberte cokoliv, co si přejete přidat 

a dále, zda chcete přidat ochranné značky podle velikosti stránky anebo 

objektu. 

 
 
 

Poznámka: “Add Registration Mark by Object” (=Přidání 

tiskových značek podle objektu) bude dáno jako automatické 

nastavení, pokud kliknete na obrázek. Zatímco “Add Registration 

Mark by page size” (přidat tiskové značky podle velikosti) bude 

dáno jako automatické nastavení, pokud kliknete na prázdnou 

oblast na stránce. 
 
 
 
 

 
Krok 4: Nyní můžete vytisknout Váš obrázek s tiskovými značkami. 

 

Můžete také přidat rychlou ikonu pro AAS Plug-in 

 

Vyberte „Tools->Options->Workspace->Customization->Commands->Macros-> 

GCCMadual.GCC_AAS_Okug_In“ a dejte OK. 
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Přidání tiskových značek podle velikosti stránky 
 
 
Pokud se rozhodnete pro “Add Registration Mark by page size”, na obrázeku níže a kliknete na “Apply”, 

Vaše tiskové značky budou vytvořeny automaticky. (Obrázek A3-1). 
 
 
Poznámka: 

1.  Nastavení délky bude v rozmezí 5-25mm v závislosti 

na velikosti stránky. 
 
 

2.  Prosím, NEprovádějte žádné změny v sekci “Origin” a 

to při výběru tiskových značek podle velikosti stránky (jak 

ukatuje obrázek dole), jinak pozice tiskových značek bude 

změněna (Obrázek A3-2). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Obrázek A3-1 
 
 

Obrázek A3-2 
 

Systém vytvoří 4 značky ve 4 rozích stránky, kamkoliv posunete Váš obrázek, viz Obrázek A3-3. 
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 

 

Obrázek A3-3 
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Pracovní plocha 

 

Umožňuje uživateli upravovat a řezat grafiku v oblasti mimo tiskové značky a to při přidání tiskových značek 

po stránce. 

 

Pro A4 formát, pracovní plocha je rozšířena o 2,5 mm od tiskových značek na levé (=Left side) a pravé straně 

(=Right side) a dále je rozšířena o 4,5 mm od tiskových značek na horní straně (=Top side). Na spodní straně 

(=Bottom side) je doporučeno nechat alespoň 25 mm od okraje fólie, aby se zabránilo jakémukoliv erroru, 

který by se mohl objevit při čtení média. 

 

Pro A3 formát, pracovní plocha je rozšířena o 10 mm od tiskových značek na levé straně, o 9 mm na pravé 

straně a dále je rozšířena o 11 mm od tiskových značek na horní straně. Na spodní straně je doporučeno nechat 

alespoň 25 mm od okraje fólie, aby se zabránilo jakémukoliv erroru, který by se mohl objevit při čtení média. 

 

 

 

Poznámka: 

Vyberte mód „Edge“ při načítání fólie pro umožnění rozvinutí fólie. Pokud vyberete mód „Single“, fólie 

nebude schopná se vrátit zpět a tím pádem nebudou detekovány přední čidla.
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Přidání tiskových značek podle objektu 
 
Pokud se rozhodnete pro “Add Registration Mark by Object”, bude Vám nabídnuta tři možnosti 

ochranných značek, viz Obrázek A3-4. 

 4-Point Positioning 

• Délka: Délka značek 
 

➢ V rozmezí: 5mm~50mm 
 

➢ Optimální nastavení: 25mm 
 

• Tloušťka: Tloušťka linie značek 
 

➢ V rozmezí: 1mm~2mm 
 

➢ Optimální nastavení: 1mm 
 

• Okraje: Vzdálenost mezi značkami a obrázky 
 

➢ V rozmezí: 0mm~50mm 
 

➢ Optimální nastavení: 5mm 
 

 

Segmental Positioning 
 

• X Krok: Vzdálenost pozice uprostřed na ose X 
 

• Y Krok: Vzdálenost pozice uprostřed na ose Y 
 

➢ Rozmezí: 200mm~600mm 
 

➢ Optimální nastavení: Méně než 500mm 
 

 

Obrázek A3-4 

 

Multiple Copies 
 

• No. of  X Copies: Počet kopií na ose X 
 

• No. of  Y Copies: Počet kopií na ose Y 
 

➢ Rozmezí: 1~50. (Čím víc kopií vyrobí, tím bude 

potřeba víc času pro přenos dat.) 

➢ Numbers of X Copies * Počet kopií = Celkový 

počet kopií obrázků 

• Copies with outline：Ukáže náhledy grafiky 
 
 
 
 

Poznámka: Hodnoty vybrány v “4-Point Positioning” sekci (délka, tloušťka a okraje) budou stále 

aplikované i když vyberete “Segmental Positioning” nebo “Multiple Copies”.
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4-Point Positioning 
 
 
 

4-Point Positioning 
 

• Délka: Délka značek 
 

➢ Rozmezí:5mm~50 mm 
 

➢ Optimální nastavení: 25mm 
 

• Tloušťka: Tloušťka linie značek 
 

➢ Rozmezí:1mm~2 mm 
 

➢ Optimální nastavení: 1mm 
 

• Okraje: Vzdálenost mezi značkami a obrázky 
 

➢ Rozmezí:0mm~50 mm 
 

➢ Optimální nastavení: 5mm 
 
 
 
 
 
 

 

Obrázek A3-5 
 
 

Systém vytvoří 4 značky a to tak, jak ukazuje obrázek níže. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Obrázek A3-6 
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Poznámka: 

1.  Chcete-li uložit Váš materiál, kromě změny okrajů obrázku, můžete také nastavit délku tiskových 

značek, (5mm minimum). Při použití 4-Point Positioning (viz tabulka 1 s návrhy v závislosti na 

velikosti materiálu). Čím menší velikost, tím kratší vzdálenost mezi objektem a tiskovou značkou. (viz 

obrázek níže). 
 
 
 
 
 
 

                    

     Oblast pro řezání 
 
 
 
 
 

Obrázek A3-7 Obrázek A3-8 
 
 
 
 
 
 
 
 
 

Velikost stránky 

(unit: mm) 

Doporučena délka značky 

(unit: mm) 

A6 (105 × 148) 5 

A5 (148 × 210) 8 

A4 (210 × 297) 11 

A3 (297 × 420) 16 

A2 (420 × 594) 23 

A1 (594 × 841) a dál 25* 
 

Tabulka 1 

*25mm je doporučení délka tiskové značky 
 
 

2. Velikost tiskové značky může mít vliv na přesnost detekce značky, proto prosím, ujistěte se, že 

velikost, kterou jste zadali, je rozumná. 
 
 

3. Pokud změníte velikost papíru, budete muset resetovat tiskové značky, jinak bude použito 

předchozí nastavení. 
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Segmental Positioning 
 
 

Pro precisní kvalitu řezání je doporučeno vybrat “Segmental Positioning” 

a to když pracuje s extra dlouhou fólií nebo velkým obrázkem. Tato volba 

zvýší přesnost. 
 
 
 

Segmental Positioning 
 

• X Step: Vzdálenost pozice uprostřed na ose X 
 

• Y Step: Vzdálenost pozice uprostřed na ose Y 
 

➢ Rozmezí:200 mm ~ 600 mm 
 

➢ Optimální nastavení: Méně než 500 mm 
 
 
 
 
 

Obrázek A3-9 
 
 
 
 
Systém je vytvoří, tak jak je ukázáno na obrázku níže. 

 

Segmental Positioning 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Obrázek A3-10 

 

Segmental position bude použit na Multiple Copies, když objekt, který má být kopírován je velké velikosti 

(s délkou nebo šířkou nad 200 mm), pro zvýšení přesnosti detekce tiskových značek. 
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Multiple Copies 

Je doporučeno zvolit “Multiple Copies”, když chcete vyrobit několik kopií jednoho obrázku, pro lepší 

přesnost řezání. 

Multiple Copies 
 

• No. of X Copies: Počet kopií na ose X 
 

• No. of Y Copies: Počet kopií na ose Y 
 

➢ Rozmezí: 1~50. (Čím víc kopií vyrobíte, tím je potřeba 

víc času na přenos dat.) 

➢ Numbers of X Copies * Počet kopií = Celkový počet 

kopií 

• Copies with outline：Budou Vám ukázány náhledy. 
• Okraje: Místo mezi značkami; musí být 0 nebo větší než 20. 

Záporné číslo není dovoleno. 
 
 
 
 
  

 
 
 
 

Obrázek A3-11 
 
 

Systém je vytvoří, tak jak je ukázáno na obrázku níže. 
 

 
 
 
 
 
 
 
 
 
 
 
 
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Obrázek A3-12 

osa Y 

osa X 
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Řezání kontur pomocí CorelDRAW 

Krok 1: Umístěte vytištěný papír s tiskovými značkami na Váš GCC řezací plotr. 

Krok 2: Vyberte “Files->Print”. 

 

Obrázek A3-13 
 
Poznámka: Pokud používáte CorelDraw X5 a výše, musíte následovat kroky níže. 

Krok 1: Klikněte na “color” stránku a běžte do “Color conversions performed by:” a poté vyberte 

model pojmenovaný po Vašem řezacím plotru. (viz Obrázek A3-14). 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Obrázek A3-14 
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Krok 2: Běžte do “Layout” stránky a vyberte na Bottom left corner v “Reposition images to”. 

   Obrázek A3-14 

 
 
Krok 3: Klikněte “Print”. 
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A-4: Illustrator Plug-In 
 

AASII VBA Installer je použitelný pro verze Adobe Illustrator 8-CS6, CC. 

 

Instalace 

Pro instalace AAS plug-in do Adobe Illustrator se odkažte na Krok 8 v Kapitole 2.8.1.2. 

 

Nastavení tisku 

Krok 1: V „Ovládací panely“ klikněte pravou myší na tiskárnu a vyberte „Vlastnosti tiskárny“. 
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Krok 2: Jděte na „Upřesnit“ a ujistěte se, že není zaškrtnutý „Zapnout vylepšené vlastnosti tiskárny“. 
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Uživatelské instrukce 

 

Krok 1: Otevřete Illustrator 

 

 

Krok 2: Editujte Váš obrázek a vytvořte obrysovou čáru (Poznámka: šířka čáry musí být nastavena na 

0.001mm). 

 

 
 

Krok 3: Klikněte na obrázek a spusťte AAS funkci (File->Scripts->_AASII_Plug_In). 
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Krok 4: Vyberte tiskové značky, které potřebujete. 

 

 
 

Krok 5: 3 typy registračních značek jsou zde popsány:4-Point Positioning, Segmental, Positioning a Multiple 

Copies.  

 

 
 

Poznámka: Hodnoty vybrány v sekci “4-Point 
Positioning” (délka, tloušťka a okraje) budou stále 
aplikované i když vyberete “Segmental 
Positioning” nebo “Multiple Copies”. 
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Krok 6: Potvrďte registrační značky (v následujících krocích je 4-Point Position použito jako ilustrační 

příklad). 

 

 
 

Krok 7: Klikněte na prázdnou část na stránce a klikněte na “Document Setup”. 
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Krok 8: Klikněte na „Edit Artboards“. 

 
 

Krok 9: Klikněte “Presets → Fit Artboard to Artwork bounds”. 
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Krok 10: Prosím, posuňte Vaši myš na lištu s nástroji v levé části, až dokončíte krok 10, klikněte na 

“Selection Tool”. 

 

 
 

Krok 11: To Vás vezme zpátky do edit módu. 
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Krok 12: Vytiskněte soubor s obrysovou čárou a tiskovými značkami. 

 

 
 

Krok 13: Umístěte vytištěný soubor na řezací plotr a dejte dolu přítlačná kolečka. Poté umístěte vozítko s 

nožem na počátek ochranných značek. 

 

Krok 14: Poštele soubor do plotru. 
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Krok 15: Vyberte model plotru, umístěte objekt do spodní části levého rohu a klikněte “Print”. 

 

 
 

 

Vaše práce je hotová. 
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Přidání registračních značek podle velikosti stránky 

 

Pokud chcete vytvořit registrační značky podle velikosti stránky, vyberte objekt a jděte do ‚Skripts‘ pod 

„File“ a vyberte _AASII_Plug_In“ 

 

 
 

Zaškrtněte „Make by page size“ a dejte „Apply“. Tiskové značky 

budou automaticky vytvořeny ve 4 rozích.  

 
 

 

Poznámka: Nastavení délky bude v rozmezí 10 – 50 mm a to podle velikosti stánky. 
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Pracovní plocha 

 

Umožňuje uživateli upravovat a řezat grafiku v oblasti mimo tiskové značky, a to při přidání tiskových značek 

po stránce. 

 

Pro A4 formát, pracovní plocha je rozšířena o 2,5 mm od tiskových značek na levé (=Left side) a pravé straně 

(=Right side) a dále je rozšířena o 4,5 mm od tiskových značek na horní straně (=Top side). Na spodní straně 

(=Bottom side) je doporučeno nechat alespoň 25 mm od okraje fólie, aby se zabránilo jakémukoliv erroru, 

který by se mohl objevit při čtení média. 

 

Pro A3 formát, pracovní plocha je rozšířena o 10 mm od tiskových značek na levé straně, o 9 mm na pravé 

straně a dále je rozšířena o 11 mm od tiskových značek na horní straně. Na spodní straně je doporučeno nechat 

alespoň 25 mm od okraje fólie, aby se zabránilo jakémukoliv erroru, který by se mohl objevit při čtení média. 

 

 
 

Poznámka: Vyberte mód „Edge“ při načítání fólie pro umožnění rozvinutí fólie. Pokud vyberete mód 

„Single“, fólie nebude schopná se vrátit zpět a tím pádem nebudou detekovány přední čidla. 
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Přidání registračních značek podle objektu 

 

Pokud chcete přidat tiskové značky podle objektu, budou Vám nabídnuty 3 typy tiskových značek. 

Nejdříve vyberte grafiku, ke které chcete přidat tiskové značky a jděte do File-> Scripts a vyberte 

„_AASII_Plug_In“. 

 
 

Odklikněte „Make by page size“ a vyberte jednu z typů tiskových značek. Popis jednotlivých typů naleznete 

v kapitole „CorelDRAW instrukce“. 
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A-5: GreatCut plug-in 
 

Uživatelský manuál GreatCut software je dostupný na instalačním DVD GCC. 
 
GCC AASII Systém 

Níže jsou instrukce o používání AAS funkce GreatCut software popsány krok za krokem 

 

Úprava obrázku v CorelDRAW. 
 
 
4-Point Positioning 

Krok 1: Vytvořte v CorelDRAW nový soubor a klikněte na ikonu „Create contour“ na GreatCut toolbat 

(objeví se automaticky, jakmile je CorelDRAW otevřený). 
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Krok 2: Dokončete nastavení kontur (včetně hodnoty offsetu kontury) a pro dokončení klikněte na 

„Calculate“  
 

 
 

Kontury se přidají k obrázku. 

 
 

 

 

 

 

Contour ofset je 
vzdálenost mezi objektem 
a linií kontury. 
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Tip: Kulatý obrys pro vektorovou grafiku 

Obecně pro vektorou grafiku jsou lepší výsledky s funkcí obrysů. Uvidíte ten rodíl mezi 

„Normal“ a „Round“ v ostrých rozích. Obrázek níže. 

 

 

 

 

 

 
 

 

 

. 

 

Normal        Round 

 

1. Klikněte na „create outline“ pro vytvoření kontury ve volně definované vzdálenosti okolo textového 

objektu. 

 

 
 

2. Vyberte „Round corners“ a nastavte hodnotu pro „offset“ a „tolerance“. 

Offset je hodnota pro vzdálenost inline a outlline od původního objektu. Tolerance indikuje, v kterém odsazení 

od rohu je bod řezu. 
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Krok 3: Klikněte na ikonu nastavení v GreatCut toolbar. 

 
 

Krok 4: Klikněte na tlačítko na pravé straně Jog marks. 
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Krok 5: Nastavte velikost, okraje objektu a tloušťku čáry tiskových značek a to v okně Setup-Jog Marks 

a dejte OK. 

 
 

Krok 6: Zaškrtněte 3 možnosti, jak ukazuje obrázek níže a klikněte OK. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

4-Point Positioning 

• Size: Délka značek 

➢ Rozmezí: 5 mm~50 mm 

➢ Optimální nastavení: 25 mm 

 

• Okraje: Vzdálenost mezi 

značkami a obrázky. 

➢ Rozmezí: 0 mm~50 mm 

➢ Optimálně: 5 mm 

 

• Tloušťka čáry: tloušťka čáry 

značek 

➢ Rozmezí: 1 mm~2 mm 

➢ Optimálně: 1 mm 
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Krok 7: Klikněte na ikonu Set Jog Marks v GreatCut toolbaru. 

 
Systém vytvoří 4 tiskové značky, tak jak ukazuje obrázek níže. 
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Poznámka: 

1.  Chcete-li uložit Váš materiál, kromě změny okrajů obrázku, můžete také nastavit délku 

registračních značek, (5mm minimum). Při použití 4-Point Positioning (viz tabulka 1 

s návrhy v závislosti na velikosti materiálu). Čím menší velikost, tím kratší vzdálenost mezi objektem 

a ochrannou značkou. (viz obrázek níže). 

                                             Oblast k řezání                                                   

 
 

Velikost stránky 

(unit: mm) 

Doporučená délka stránky 

(unit: mm) 

A6 (105 x 148) 5 

A5 (148 x 210) 8 

A4 (210 x 297) 11 

A3 (297 x 420) 16 

A2 (420 x 594) 23 

A1 (594 x 841) a více 25* 
 

Tabulka 1 

*25mm je doporučená hodnota tiskových značek.  
 
 

2. Velikost tiskové značky může mít vliv na přesnost detekce značky, proto prosím, ujistěte se, že částku, 

kterou jste zadali, je rozumná. 
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Výstup 

Krok 1: Vyberte všechny objekty (včetně tiskových značek a kontur) a klikněte na ikonu Cut v toolbaru 

GreatCut. 

 

Krok 2: Systém automaticky zapne GreatCut a importuje tiskové značky a kontury do GreatCut. 
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Krok 3: Vyberte Soubor-> Výstup na zařízení 

 

 

Krok 4: Vyberte Řezání s AAS v Režim/Nástroje v okně Výstupu na zařízení. Dále dokončete nastavení 

parametrů (ofset, rychlost, přítlak, tloušťka atd.). 
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Krok 5: Klikněte na Výstup (=Output) a objekt bude poslán do GCC řezacího plotru. 
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Poznámka: Různé množství najdete v okně Výstup na zařízení; Počet výstupů, počet kopií a počet kroků. 

 

 

 

1. Když „Počet výstupů“ je nastaven na 2, čtverec a trojúhelník budou vyřezány jednou a poté čtverec a 

trojúhelník budou vyřezány znova na další pozici. 

 

2. Když „Počet kopií“ je nastaven na 2, čtverec a trojúhelník budou vyřezány dvakrát na stejné pozici. 

 

3. Když „Počet kroků“ je nastaven na 2, čtverec bude vyřezán dvakrát na stejné pozici a trojúhelník 

bude vyřezán dvakrát na stejné pozici.
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Pokročilé nastavení 

Segmental Positioning 

Pro precisní kvalitu řezání je doporučeno vybrat “Segmental Positioning” a to když pracuje s extra 

dlouhou grafikou nebo velkým obrázkem tato volba zvýší přesnost. 

 

Následujte stejné kroky jako v sekci 4-Point Positioning pro dokončení nastavení kontur a tiskových 

značek. Nastavte velikost, okraje objektu a tloušťku čáry tiskových značek a vzdálenost mezi tiskovými 

značkami pomocí změny X, Y vzdálenosti v okně Setup-Jog window a klikněte na OK. 
 
 
 
 
 
 

 

              Segmental Positioning 
 
 
     

Max. x Distance: Vzdálenost 

pozice uprostřed na ose X 

➢ Rozmezí: 200-500 mm 

Max. y Distance: Vzdálenost pozice 
uprostřed na ose Y 

➢ Rozmezí: 200-500 mm 
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Systém vytvoří značky, jako na obrázku níže.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
           Osa Y 
 
 
 
 
 
 
 
 
 
 

Osa X 
 
 
 
 
 
 
 

 

Segmental Positioning 

 

Následujte stejné kroky, jako v části Výstup pro výstup grafiky do řezacího plotru GCC. 
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Multiple Copies 

 

Následujte stejné kroky jako v sekci 4-Point Positioning pro kompletaci nastavní kontur a tiskových 

značek. 
 
 
 
 
 
 
 
 
 

Když vyberete funkci “Multiple 

Copies”, hodnota, která byla 

nastavena v této sekci, bude stále 

platit.  

 

0

20

40

60

80

100

1. čtvrt. 2. čtvrt. 3. čtvrt. 4. čtvrt.

Východ

Západ

Sever

 
 
 
 
 
 
 
 
 
 
 

Klikněte na ikonu Set Jog Marks na GreatCut toolbaru a budou vytvořená 4 značky, tak jak je na obrázku 

níže. 
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Klikněte na ikonu Multi-copy na toolbar GreatCutu a doplňte počet v Number in X a Y a Distance in X/Y 

a klikněte OK. 

 

 

 
 

Poznámka: Horizontální a vertikální rozestup (Offset X a Y) musí být ≥ 20 mm nebo = 0 mm. Uživatelům 

se doporučuje nastavit vzdálenost v X/Y na 0 mm pro odebrání mezery mezi každé kopii, aby se zabránilo 

plýtvání materiálem. 
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Systém vytvoří několik kopií objektu s tiskovými značkami, tak jak je uvedeno na obrázku níže. 

 

 
 

 

Následujte stejné kroky, jako v sekci Výstup, pro řezání Vaší grafiky pomocí řezacího plotru GCC. 
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Editování obrázku v Adobe Illustrator 

 

4-Point Positioning 

Krok 1: Vytvořte nový soubor v Adobe Illustrator. 

 

 
 

Krok 2: Označte obrázek a jděte do File->GreatCut->Contour 
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Krok 3: Dokončete nastavení Kontur (včetně Contour ofset) a pro potvrzení klikněte na Calculate. 

 

 
 

Čára obrysu je nyní přidána k objektu. 

 

Contour ofset je vzdálenost mezi 

objektem a čárou obrysu. 



 138 

 
 

 

 

 
 

 

 

 

 

 

 

 

Tip: Kulatý obrys pro vektorovou grafiku 

Obecně pro vektorou grafiku jsou lepší výsledky s funkcí outline. Uvidíte ten rodíl mezi „Normal“ a 

„Round“ v ostrých rozích. Obrázek níže. 

 

 

 

 

 

 
 

 

 

. 

 

Normal        Round 

 

1. Klikněte na File-> GreatCut-> „Outline“ pro vytvoření kontury ve volně definované vzdálenosti 

okolo textového objektu. 
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2. Vyberte „Round corners“ a nastavte hodnotu pro „offset“ a „tolerance“. 

Offset je hodnota pro vzdálenost inline a outlline od původního objektu. Tolerance indikuje, v kterém 

odsazení od rohu je bod řezu. 
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Krok 4: File-> GreatCut-> Settings 

 
 

Krok 5: Klikněte na pravé tlačítko od Jog marks 
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Krok 6: Nastavte velikost tiskových značek, jejich okraje obrázku a tloušťku čar a klikněte na OK. 

 
 

Krok 7: Zaškrtněte náledující tři možnosti (obrázek níže). 

 
 

 

 

 

 

 

 

 

 

 

 

 

4-Point Positioning 

Size: Délka značek 

Rozmezí: 5 mm~50 mm 

Optimální nastavení: 25 mm 

Okraje: Vzdálenost mezi 

značkami a obrázky. 

Rozmezí: 0 mm~50 mm 

Optimálně: 5 mm 

Tloušťka čáry: tloušťka čáry 

značek 

Rozmezí: 1 mm~2 mm 

Optimálně: 1 mm 
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Krok 8: Klikněte na File-> GreatCut-> Jog Marks 

 

 
 

Systém vytvoří 4 značky, viz obrázek níže. 
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Výstup 

 

Krok 1: Vyberte všechny objekty (včetně tiskových značek a kontur) a klikněte na File-> GreatCut-> Cut 

 
 

Krok 2: Systém automaticky otevře GreatCut a importuje tiskové značky a kontury do GreatCut. 

 

 
 

 

Krok 3: Vyberte Soubor-> Výstup na zařízení 
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Krok 4: Vyberte Řezání s ASS (=Cut with AAS) v Režim/Nástroje v okně Výstuu na zařízení. Dále 

dokončete nastavení parametrů (offset, rychlost, přítlak, tloušťka atd.). 
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Krok 5: Klikněte na Výstup a objekt bude poslán do řezacího plotru GCC. 
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Poznámka: Nastavení různého množství najdete v okně „Výstup na zařízení“; Počet výstupů, počet kopií 

a počet kroků. 

 

 

 

1. Když „Počet výstupů“ je nastaven na 2, čtverec a trojúhelník budou vyřezány jednou a poté čtverec 

a trojúhelník budou vyřezány znova na další pozici. 

 

2. Když „Počet kopií“ je nastaven na 2, čtverec a trojúhelník budou vyřezány dvakrát na stejné pozici. 

 

3. Když „Počet kroků“ je nastaven na 2, čtverec bude vyřezán dvakrát na stejné pozici a trojúhelník 

bude vyřezán dvakrát na stejné pozici. 
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Pokročilé nastavení 

Segmental Positioning 

Pro precisní kvalitu řezání je doporučeno vybrat “Segmental Positioning” a to když pracuje s extra 

dlouhou grafikou nebo velkým obrázkem tato volba zvýší přesnost. 

 

Následujte stejné kroky jako v sekci 4-Point Positioning pro dokončení nastavení kontur a tiskových 

značek. Nastavte velikost, okraje objektu a tloušťku čáry tiskových značek a vzdálenost mezi tiskovými 

značkami pomocí změny X, Y vzdálenosti v okně Setup-Jog Marks a klikněte na OK. 
 
 
 
 
 
 

 

              Segmental Positioning 
 
 
     

Max. x Distance: Vzdálenost 

pozice uprostřed na ose X 

➢ Rozmezí: 200-500 mm 

Max. y Distance: Vzdálenost pozice 
uprostřed na ose Y 

➢ Rozmezí: 200-500 mm 
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Krok 1: Klikněte na File-> GreatCut-> Set Jog Marks 

 

 

 

 

 

 

 

 



 149 

 
 

 

 

Krok 2: Následujte stejné kroky jako v sekci 4-Point Positioning pro kompletaci nastavení. 

 

 

Krok 3: Dejte File- > GreatCut-> Set Jog Marks a systém vytvoří 4 tiskové značky.  

 

Když vyberete funkci 

“Multiple Copies”, 

hodnota, která byla 

nastavena v této sekci, 

bude stále platit. 
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Krok 4: Klikněte na File-> GreatCut-> Multi-Copy 
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Krok 5: Doplňte počet Number in X/Y a Distance in X/Y a klikněte na OK. 

 

 

Poznámka: Horizontální a vertikální rozestup (Offset X a Y) musí být ≥ 20 mm nebo = 0 mm. Uživatelům 

se doporučuje nastavit vzdálenost v X/Y na 0 mm pro odebrání mezery mezi každé kopii, aby se zabránilo 

plýtvání materiálem. 

 

Krok 6: Systém vytvoří několik kopií objektu s tiskovými značkami, jako je na obrázku níže. 

 

 

Pokračujte podle stejných kroků v sekci Výstup pro výstup objektů na GCC řezacím plotru. 
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A-6: SignPal 12 

Nová verze SW SignPal 12 je kompatibilní k Windows Systemu a pro všechny verze podporující funkci 

AAS II. 

 
 

SignPal 12 Instrukční Index: 

[1] Instalace SW SignPal 12 

[2] Nastavení GCC stroje v Manageru produktů 

[3] SignPal AAS II Rychlý Start  

[4] SignPal 12: List vlastností 

 
 

 

[1] Instalace softwaru SignPal 12 

Pro instalování tohoto software, musíte mít administrátorský privilegia. Pro použití software musíte 

mít administrátorský nebo power uživatelská privilegia. 

 

1. Odinstalujte jakékoliv předešlé verze softwaru. 

2. Jděte na stránku GCC Clubu (http://gccf.gcc.com.tw/gccclub/login.aspx) a přihlaste se. Dále vyberte 

Drivers > Cutter > Others > SignPal 12 k nahrání souboru ve formátu WinRAR. 

  

 
 
 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

3. Následujte kroky instalace a instrukce k instalace vizte níže 
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(1) Instalace a aktivace softwaru na online počítači (počítač připojený k síti) 

 
1. Otevřete váš prohlížeč a přejděte na následující link https://www.saicloud.com  , poté vložte 

váš aktivační kód a poté klikněte na Activate, Aktivační kód lze nalézt v originálním balení 
softwaru.  

 
 

2. V přihlašovací části, vyberte I am new to the SAi Cloud a vložte vaši emailovou adresu, poté klikněte na 

Create Account,  dna zadanou emailovou adresu Vám bude zaslán email. 
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3. Zkontrolujte vaši emailovou schránku a klikněte na webový link v emailu a vyplňte formulář. 

 
Krok č.2 Přidejte váš software k účtu SAi Cloud 
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4. Otevřete Autorun v souboru WinRAR. Poté můžete nainstalovat software krok za krokem dle 

následujících krokům: 
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5.Vložte aktivační kód do aktivačního pole.  

 

 

 
 

 

6.Vyberte požadovaný jazyk a potvrďte tlačítkem OK a dokončete instalaci. 
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(2) Instalace a aktivace softwaru SignPal 12 v offline režimu  
1.Otevřete Autorun v souboru WinRAR. Pak nainstalujte software krok po kroku dle kroků níže: 
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2. Nahrajte ID vašeho počítače to dialogového boxu níže a nechte vyhledat název vašeho počítače. Název 

počítače zjistíte pomocí kliku pravou myší na My Computer a vyberete Properties. 

 

 

  
 

 

 

3. Otevřete internetový prohlížeč na druhém počítači, kde jste připojeni k síti a jděte na stránku 

https://www.saicloud.com  . Zde vložte aktivační kód a klikněte na Activate.  
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4.V sekci přihlášení, vyberte I am new to the SAi Cloud a vložte vaši emailovou adresu a pak klikněte na 

Create Account, email bude odeslán do vaší emalové schránky.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Zkontrolujte příchozí poštu a přejděte na link v emailu. 

 
 

 
5. Klikněte na “License Manager” can’t connect a vložte ID číslo a jméno počítače, které jste si předtím 

zajistili. Pak klikněte na Create license Now a Download License, uložte licenci do místní složky. 
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6. Okopírujte složku licence do offline počítače  
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7. Vyberte jazyk a pak klikněte na OK a dokončete instalaci. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(2) Přenesení licence na online počítač 
 

1. Otevřete License Manager z nabídky Start menu 

 
 
 

 
2. Klikněte na Remove License From This computer, V tento moment můžete nainstalovat software 

do jiného počítače. 
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(4) Přenesení licence na offline počítač 

1. Otevřete License Manager z nabídky Start menu 

 
2.Klikněte na Remove License From This computer, a poté přesuňte licenční kód do dialogového 
boxu. 

 
 
3.V jiném počítači, který je připojen k síti přejděte na stránku URL https://www.saicloud.com a 
přihlašte se pomocí vašeho účtu. Poté klikněte na License Removed , vložte kód a klikněte na 
Remove. Po tomto kroku lze instalovat software do jiného počítače. 
 
 
 
 
 
 
 
 

https://www.saicloud.com/
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. 
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[2] Nastavení Vašeho GCC řezacího plotru v  Manageru produktů  
 
 

1. Otevřete Production Manager 12. 

2. Vyberte a nastavte Váš GCC řezací plotr. 

(Nezapomeňte, že systém AAS II, pracuje pouze na Jaguar IV, RX II, Puma III, Expert 24 LX a Expert 

52 LX) 
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3. Vyberte File > Print Setup v SignPal Software. 
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4. Vyberte tiskárnu a velikost papíru. 
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[3]SignPal AASII Rychlý Start 
 

 
5. Použijte Rectangle Tool pro vytvoření obdélníku.  

 

 

 
6. Vyberte Effect > Contour Cut a poté klikněte ‘Apply’ v DesignCentral okně. 
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7. Použijte značku pro řezání kontur GCC AASII tím že vyberete Effect > Contour Cut Mark. 

 
 
 

8. Vyberte “GCC AASII” v SignPal DesignCentral okně pro vytvoření AAS II tiskových známek (4-Point 

Positioning). Nastavte hodnoty na 0.1 cm a více a klikněte ‘Apply’ v DesignCentral okně. Tato hodnota je 

definována jako vzdálenost mezi tiskovými značkami a oblastí obrázku. Pokud je hodnota menší než 0.1 

cm, je pravděpodobné, že obrázek bude přesahovat přes značky a výsledek bude špatná kvalita řezu. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Jsou tři typy GCC AASII tiskových značek: 4-Point Positioning, Segmental Positioning a Multiple 

Copies. Pro tvorbu ‘Segmental Positioning’ značek, prosím vyberte “GCC Segmentation” v okně 

DesignCentral a poté klikněte na ‘Apply’. 
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10. ‘Multiple Copies’ funkce není dostupná v SignPal. Momentálně ‘Multiple Copies’ 

funkce je dostupná pouze pod CorelDraw plug-in. 
 

 
11. Vyberte File > Print pro vytisknutí obrázku. 
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12. Nastavte měřítko na 100cm =1m (100%) v Print page. 
 

 
 

 

13. Načtěte fólii do plotru a vyberte File > Cut Contour pro poslání dat. Můžete zkontrolovat Vaši práci 

a změnit řezací parametry v ‘Properties’ v Cut Contour okně. Production Manager bude automaticky 

aktivován pro dokončení práce.  
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[4]SignPal 12 List vlastností 
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A-7: Sure Cuts A lot 
 

Tato část obsahuje základní instrukce k Sure Cuts a Lot. Pokud potřebujete detailnější informace, odkažte 

se na Sure Cuts A Lot Help. 

 

1. Vyberte plotr, ze kterého chcete řezat a změňte pracovní plochu. 

 

Krok 1: Zapněte software Sure Cuts A Lot 

   
 

Krok 2: Pro změnu pracovní plochy vyberte „Cutter“ a „Manage Cutters“ pod „My Cutter“. 

 

  
 

Krok 3: Vyberte GCC pod company/ brand a vyberte model, z kterého chcete řezat a poté klikněte na 

tlačítko „Add to list“. 
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Krok 4: Na levé straně vyberte GCC a klikněte „Done“. 

  
 

Krok 5: Pokud chcete změnit velikost materiálu a orientaci, můžete vyplnit odpovídající hodnoty do 

okna Document. 
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2. Vložit grafiky z Knihovny 

Krok 1: Vyberte grafiky z knihovny pro vložení vybraných designů. 

 
 

3. Vložení textu 

 

Klikněte na ikonu „T“ na levé straně, díky které vložíte text a můžete použít různé fonty, které si můžete 

vybrat v okně Text. 
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4. Importování Designů 

Pokud jste si vytvořili svůj design v jiném softwaru můžete ho importovat pomocí „import“ nebo „place 

image“ pod File. Sure Cuts A Lot podporuje následující přípony: svg, scut, scal, pdf, ai. wpc eps, bmp, 

gif, jpg a png. 

 
 

Tip: Tisíce SVG souborů vytvořeny speciálně pro Sure Cuts A Lot! 

http://SVGCuts.com je hlavním zdrojem pro SVG designy pro Sure Cuts A Lot. Tisíce vysoce kvalitních 

prvků, včetně tvarů pro cardmaking, scrapbooking, také tvary pro dárkové tašky a 3D kytky. 

  

http://svgcuts.com/
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5. Převod grafiky na Řezací soubor. 

 

Krok 1: Klikněte na File -> Trace Image nebo na Trace Image tlačítko na toolbaru. 

 
 

Krok 2: Klikněte na „Choose an image“ pro výstup obrázku. Nastavte Image Setting a Output Settings a 

klikněte OK. Poté se Vám automaticky zobrazí náhled. 

 
 

Poznámka: Kontrast a pixely importovaných obrázků budou mít vliv na výsledky trasování obrazu. Jsou 

doporučeny vysoce kontrastní grafiky. 

 

 

 



 
 

 

 182 

6. Řezaní designu. 

 

Krok 1: Klikněte na tlačítko „Cutter“ na toolbaru a objeví se Vám okno Cut Settings. 

 
 

Krok 2: Klikněte na „Settings…“ pro otevření okna GCC Cutter Settigns. 

 
 

Poznámka: Počáteční bod je v pravém dolním rohu. 

 

Krok 3: V okně GCC Cutter Settings můžete nastavit tiskové značky. 

 
Registrační značky: Nastavení vzdálenosti mezi okrajem materiálu a tiskové značky v Mark Ofset; 

nastavení velikosti tiskových značek v Mark Size; nastavení tloušťky čár tiskových značek v Mark 

Thickness. 

Krok 4: Nastavte Blade Ofset (=ofset nože), Overcut Value (=hodnota přeřezání), Multi-Cut a Quality 

v okně Cut Setting. 
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Blade ofset: Nastavte hodnotu offsetu podle různosti nože, pro standardní nůž nastavte hodnotu offsetu 

na 0,25 mm, 0,5 pro pokročilý volitelný nůž a 0 mm pro volitelné krelící pero. 

Quality: Souvisí s výsledkem řezu; uvědomte si, že čím větší kvalita řezu, tím menší rychlost řezu. 

Multi-Cut: Pro opakování řezání na stejné pozici, což je vhodné pro řezání tlustých materiálů. 

OverCut: Slouží pro jednodušší separaci a vynahradí neúplné linie. 

 
 

 

 

 

 

 

 

Krok 5: Pod sekcí „Cut Settings“ najdete několik užitečných funkcí. Po nastavení parametrů klikněte na 

„Cut“ pro odeslání dat do GCC řezacího plotru a plotr začně řezat. 
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Cut Mode: Jsou možnosti „WSIWYG“ a „Origin Point“. WSIWYG znamená, co vidíte, to dostanete-> 

Plotr vyřeže grafiku na stejném místě, jako je vidět na náhledu. Zatímco Origin Point znamená, že plotr 

vyřeže grafiku od pravého dolního rohu. 

Use Software Speed and Pressure: Zaškrtněte tuto možnost a můžete nastavit manuálně hodnotu 

rychlosti a tlaku. 

Preset: Vyberte správný materiál pro použití předvolby hodnoty rychlosti a tlaku automaticky. 

Speed & Pressure: Možná budete chtít nastavit hodnoty rychlosti a tlaku manuálně pro získání lepší 

kvality. 
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7. Tisk a řezání Vašeho designu (Print and Cut) 

 

Funkce Print and Cut Vám umožňuje vytisknout grafiku z Sure Cuts A Lot ve Vaší tiskárně a poté vložit 

vytištěný materiál do GCC plotru pro řezání pomocí tiskových značek ze softwaru. 

 

Krok 1: Otevřete soubor obrázku v Sure Cuts A Lot 

 
 

Krok 2: Klikněte na ikonu Cutter na toolbaru, nastavtet parametry a klikněte na tlačítko „Print+Cut“ pro 

přidání tiskových značek a vytiskněte obrázek. 

 
 

 

Krok 3:  Klikněte na „Print…“ pro otevření okna nastavení tiskárny a stiskněte OK. 
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Krok 4: Vytiskněte Váš design s tickovými značkami. 

 

 
 

Krok 5: Vložte vytištěný materiál do GCC plotru. 

 

Krok 6: Klikněte na „Next“ a poté na „Scan+Cut“ a poté GCC plotr bude detekovat tiskové značky a řezat 

obrysu automaticky. 
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Tip: Funkce: Test propojení Vám může ušetřit materiál. Klikněte na „Test Connection“ pro vyzkoušení, 

zda je vše správě propojené. 
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A-8: GreatCut-S krátký návod 
 

Níže naleznete základní manuál k řezacímu softwaru GreatCut-S. Pokud potřebujete podrobný návod, 

podívejte se do nápovědy přímo v softwaru GreatCut-S Help (na horní liště). 

 

Vybrání řezací plotru a změna pracovní plochy 

1. Otevřete GreatCut-S 

 
2. Vyberte „Cutter“ a vyberte „My Cutter“ ->  „Manage Cutters“ . 

 
 

3. Vyberte v části Company/Brand značku GCC a vyberte model řezacího plotru, který vlastníte. Poté 

klikněte na tlačítko 🡨 -- Add to list. 
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4. Vyberte GCC na levé straně a klikněte na tlačítko Done. 

 
 

5. Pokud chcete změnit velikost a orientaci materiálu, můžete vyplnit požadovanou velikost v okně 

Document. 

 
Vložení grafiku z knihovny 

Vyberte grafiku z knihovny a vyberte požadovaný design. 
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Vložení textu 

Klikněte na ikonu „T“ na levé straně a vyberte požadovaný font v okně na pravé straně. 
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Importování designu 

Pokud jste návrh vytvořili v jiném softwaru, přejděte na možnost „Import“ nebo „Place image“ pod 

možností „File“. GreatCut-S podporuje soubory svg, scut, scal, pdf, ai. wpc eps, bmp, gif, jpg a png. 

 
 

TIP: Tisíce SVG souborů k dispozici v SVGCuts: http://SVGCuts.com je top zdrojem pro soubory SVG. 

Tisíce vysoce kvalitních prvků včetně: tvarů pro výrobu přáníček, scrapbooking, ale i dárkových tašek, 

krabiček a 3D modelů květů. 

 

Převod obrázku do souboru pro řezání 

1. Klikněte na File → Trace Image nebo vyberte ikonu pro převod obrázků v horní liště nástrojů. 

Otevře se vám okno s nastavením. 

 
 

 

 

 

 

 

http://svgcuts.com/
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2. Kliknutím na „Choose an image“ (Zvolit obrázek) vložíte obrázek, upravíte obrázek a nastavíte řezání 

a poté klikněte na OK. Poté se obrys obrázku automaticky zobrazí na výstupu. 

 
Poznámka: Kontrast a pixely importovaných obrázků ovlivní výsledek trasování obrázku. Doporučuje se 

používat grafiku s vysokým kontrastem. 

 

Řezání designu 

1. Klikněte na tlačítko „Cutter“ na horní liště nástrojů a objeví se vám okno. 

 
2. Klikněte na tlačítko „Settings..“ pro otevření okna nastavení. 

 
TIP: Počáteční bod je v dolním pravém rohu. 
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3. Pokud potřebujete tak nastavte registrační značky v okně „GCC Cutter Settings“. 

 
*Registrační značky: nastavte vzdálenost mezi okrajem materiálu a registračními značkami v položce 

Mark offset; nastavte velikost značek v položce Mark size; nastavte tloušťku čáry značek v položce 

Mark thickness. 

 

4. Nastavte Offset, OverCut hodnotu, Multi-Cut (vícenásobné kopie) a Quality (kvalitu) v sekci „Cut 

Settings“ 

 
 

Blade Offset: nastavte hodnotu odsazení podle různých nožů, pro standardní nůž nastavte hodnotu 

offsetu na 0,25 mm, 0,5 mm pro volitelný pokročilý nůž a 0 mm pro volitelné vykreslovací pero. 

Kvalita: souvisí s výsledkem řezání; mějte na paměti, že čím lepší kvalita řezání, tím nižší rychlost 

řezání. 
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Vícenásobný řez: opakování řezací úlohy ve stejné poloze, které je vhodné pro řezání silného materiálu. 

Overcut: umožňuje snadnější separaci materiálu a doplňuje neúplné linie řezu. 

5. V sekci „Cut Settings“ najdete užitečné funkce. Po nastavení parametrů klikněte na „Cut“ a tím 

pošlete úlohu do řezacího plotru, který začne řezat. 

 
- Cut Mode: k dispozici jsou možnosti „WSIWYG“ a „Origin Point“, WSIWYG znamená, že to, co 

vidíte, je to, co dostanete, řezací plotr vyvede grafiku na stejnou pozici v okně náhledu. Zatímco v 

režimu Origin Point bude plotr řezat grafiku od pravého dolního počátečního bodu materiálu. 

- Use Software Speed and Force (použít rychlost a přítlak softwaru): zaškrtněte tuto část a můžete ručně 

nastavit hodnoty rychlosti a přítlaku. 

- Preset: Vyberte vhodný materiál, na který se automaticky použijí přednastavené parametry rychlosti a 

přítlaku. 

- Speed & Pressure: hodnoty rychlosti a tlaku můžete nastavit ručně, abyste dosáhli kvalitních výsledků. 

 

Vytisknutí a řezání grafiky 

Funkce v softwaru Print+Cut umožňuje vytisknout grafiku z GreatCut-S na tiskárně a poté vložit 

vytištěný materiál do řezacího plotru a ořezat podle registračních značek. 

1. Otevřete soubor v GreatCut-S 
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2. Klikněte na ikonu Cutter na panelu nástrojů a otevře se vám okno pro nastavení řezání. 

 
3. Klikněte na možnost „Settings…“, otevře se vám okno nastavení. 

 
 

4. V okně nastavení nastavte parametry registračních značek. 
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5. Nastavte parametry řezání a klikněte na "Print+Cut", čímž se přidají registrační značky.  

 
 

6. V nově otevřeném okně klikněte na tlačítko „Print…“, čímž se vám otevře okno nastavení tiskárny 

a klikněte na OK. 

 
 

7. Vytisknete vaši grafiku s registračními značkami. 

 
 

 

8. Vložte do řezacího plotru vytištěnou grafiku. 

9. Klikněte na tlačítko „Next“ a poté klikněte na tlačítko „Scan+Cut“, čímž GCC plotr rozpozná 

registrační značky a automaticky je ořeže. 
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TIP: Test připojení vám může ušetřit materiál. Klikněte na „Test Connection“ a vyzkoušejte, za je 

připojení správně nastaveno. 

 

 
 

Řezání podle barev 

Funkce Řezání podle barev umožňuje vybrat, které barvy v návrhu chcete řezat, a každé barvě přiřadit 

jiné parametry. Své návrhy můžete řezat v jedné úloze nebo v samostatných úlohách pro každou barvu. 

1. Vyberte design a specifikujte pro něj barvu. 
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2. Poté definujte typ řezání a parametry. 
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3. Klikněte na tlačítko „Cut“, čímž se vám otevře nastavení řezání. 

 
 

4. Klikněte na záložku „Cut By Color“ (Řezat podle barev) a vyberte, zda chcete řezat všechny barvy 

v jedné úloze (Cut all colors), nebo každou barvu zvlášť (Cut each color separately) jako samostatnou 

úlohu. Pokud je vybrána možnost Řezat každou barvu zvlášť, software GreatCut-S vás před zahájením 

řezání vyzve, abyste mezi jednotlivými barvami načetli příslušnou barvu nebo odpovídající nástroj do 

řezacího plotru. 

 

Poznámka: Pokud se pro všechny barvy v řezací úloze používá stejný nástroj, doporučuje se použít 

možnost „Řezat všechny barvy (jedna úloha)“. 

 
 

 

 

 

 

 

 

 

 



 
 

 

 200 

5. Kliknutím na ikonu nože vyberete barvy, které chcete řezat. V náhledu se zobrazí, které barvy jsou 

aktuálně povoleny pro řezání. 

Poznámka: Pořadí uspořádání vrstev můžete upravit kliknutím a přetažením vrstvy. 

 

 
6. Klikněte na tlačítko „Cut“, čímž zahájíte řezání. 
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Likvidace výrobku a jeho částí 
 

Při závěrečném vyřazení z provozu stroje (po skončení životnosti stroje), mějte na paměti zájem a hledisko 

ochrany životního prostředí a recyklační možnosti: Zlikvidujte toxické odpady (např. baterie) podle předpisů. 

Oddělte plastické materiály a nabídněte je pro recyklaci. Oddělte kovové části podle typu pro šrotování. 

 

Informace pro uživatele k likvidaci elektrických a elektronických zařízení (domácnosti) 

 

Uvedený symbol na výrobku nebo v průvodní dokumentaci znamená, že použité 

elektrické nebo elektronické výrobky nesmí být likvidovány společně s komunálním 

odpadem. Za účelem správné likvidace výrobku jej odevzdejte na určených sběrných 

místech, kde budou přijata zdarma. 

Správnou likvidací tohoto produktu pomůžete zachovat cenné přírodní zdroje a 

napomáháte prevenci potenciálních negativních dopadů na životní prostředí a lidské 

zdraví, což by mohly být důsledky nesprávné likvidace odpadů. Další podrobnosti 

si vyžádejte od místního úřadu nebo nejbližšího sběrného místa. 

Při nesprávné likvidaci tohoto druhu odpadu mohou být v souladu s národními předpisy 

uděleny pokuty. 

 

Informace pro uživatele k likvidaci elektrických a elektronických zařízení (firemní a podnikové použití) 

Pro správnou likvidaci elektrických a elektronických zařízení si vyžádejte podrobné informace u Vašeho 

prodejce nebo dodavatele. 

  

Informace pro uživatele k likvidaci elektrických a elektronických zařízení v ostatních zemích mimo Evropskou unii. 

Výše uvedený symbol je platný pouze v zemích Evropské unie. Pro správnou likvidaci elektrických 

a elektronických zařízení si vyžádejte podrobné informace u Vašich úřadů nebo prodejce zařízení 

 

Bezpečnostní instrukce: 
 

1. Přečtěte si všechny instrukce k obsluze stroje. 

2. Používejte přístroj pouze k tomu, k čemu byl určen. 

3. Abyste snížili riziko elektrického šoku, nepotápějte přístroj do vody nebo nepolévejte přístroj 

jinými kapalinami. 

4. Při odpojování nikdy netahejte kabel ze zásuvky, místo toho uchopte zástrčku a kabel vytáhněte. 

5. Kabel se nesmí dotýkat teplých ploch, nechte přístroj vychladnout, než odpojíte kabel. 

6. Nepracujte s přístrojem, pokud je kabel poškozený nebo pokud přístroj nebo jeho část je 

poškozena či zničena. Abyste snížili riziko elektrického šoku, nerozebírejte nebo nezkoušejte 

opravit přístroj, odneste ho do autorizovaného servisu na zkoušku nebo případnou opravu. 

Nesprávná opětovná montáž nebo oprava může být rizikem k vzniku požáru, elektrického šoku 

nebo může způsobit úraz osobám, které přístroj používají. 

7. Nenechávejte přístroj bez dozoru, pokud je zapojen. Přístroj mohou používat pouze osoby 

starší 18 let. 

8. Při dotyku s teplými kovovými částmi může dojít k popáleninám. 

9. Abyste snížili pravděpodobnost přetížení elektrického obvodu, nepracujte s dalšími 

přístroji s vysokým napětím ve stejném obvodu. 

10.  Pokud je nezbytně nutný prodlužovací kabel, měli byste použít 20ti ampérový. Při použití kabelu určeném 

na menší velikost proudu, může dojít k přetížení. Je třeba dbát, abyste kabel umístily tak, aby nebyl napnutý 

anebo o něj někdo nezakopl. 

 

Technici firmy GCC řezací plotry neustále vylepšují. V této souvislosti je možné, že již Váš plotr má nějaké 

nové vylepšení, nebo rozšíření o další funkce. Podrobnější informace jsou v originální příručce na CD s ovladači 

ve složce – User manual. 

 

 

 

 


